Windchill PDMLink, Windchill ProjectLink, and Windchill SupplyLink.

Patents of Parametric Technology Corporation or a Subsidiary
Registration numbers and issue dates follow. Additionally, equivalent patents may be issued or pending outside of the United States. Contact PTC for further information.

<table>
<thead>
<tr>
<th>Patent Number</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>GB2366639B</td>
<td>13-October-2004</td>
</tr>
<tr>
<td>GB2363208</td>
<td>25-August-2004</td>
</tr>
<tr>
<td>(EP/DE/GB)0812447</td>
<td>26-May-2004</td>
</tr>
<tr>
<td>GB2365567</td>
<td>10-March-2004</td>
</tr>
<tr>
<td>(GB)2388003B</td>
<td>21-January-2004</td>
</tr>
<tr>
<td>6,665,569 B1</td>
<td>16-December-2003</td>
</tr>
<tr>
<td>GB2353115</td>
<td>10-December-2003</td>
</tr>
<tr>
<td>6,625,607 B1</td>
<td>23-September-2003</td>
</tr>
<tr>
<td>6,580,428 B1</td>
<td>17-June-2003</td>
</tr>
<tr>
<td>GB2354684B</td>
<td>02-July-2003</td>
</tr>
<tr>
<td>GB2384125</td>
<td>15-October-2003</td>
</tr>
<tr>
<td>GB2354096</td>
<td>12-November-2003</td>
</tr>
<tr>
<td>GB2354924</td>
<td>24-September-2003</td>
</tr>
<tr>
<td>6,608,623 B1</td>
<td>19-August-2003</td>
</tr>
<tr>
<td>GB2353376</td>
<td>05-November-2003</td>
</tr>
<tr>
<td>GB2354686</td>
<td>15-October-2003</td>
</tr>
<tr>
<td>6,545,671 B1</td>
<td>08-April-2003</td>
</tr>
<tr>
<td>GB2354685B</td>
<td>18-June-2003</td>
</tr>
<tr>
<td>GB2354683B</td>
<td>04-June-2003</td>
</tr>
<tr>
<td>6,608,623 B1</td>
<td>19-August-2003</td>
</tr>
<tr>
<td>GB2354686</td>
<td>15-October-2003</td>
</tr>
<tr>
<td>6,580,428 B1</td>
<td>10-Sept-2002</td>
</tr>
<tr>
<td>6,308,144</td>
<td>23-October-2001</td>
</tr>
<tr>
<td>5,880,523</td>
<td>21-October-1997</td>
</tr>
<tr>
<td>5,838,331</td>
<td>17-November-1998</td>
</tr>
<tr>
<td>4,956,771</td>
<td>11-September-1990</td>
</tr>
<tr>
<td>5,058,000</td>
<td>15-October-1991</td>
</tr>
<tr>
<td>5,140,321</td>
<td>18-August-1992</td>
</tr>
<tr>
<td>5,423,023</td>
<td>05-June-1990</td>
</tr>
<tr>
<td>4,310,614</td>
<td>21-December-1998</td>
</tr>
<tr>
<td>4,310,614</td>
<td>30-April-1996</td>
</tr>
<tr>
<td>4,310,614</td>
<td>22-April-1999</td>
</tr>
<tr>
<td>5,297,053</td>
<td>22-March-1994</td>
</tr>
<tr>
<td>5,513,316</td>
<td>30-April-1996</td>
</tr>
<tr>
<td>5,699,711</td>
<td>18-November-1997</td>
</tr>
<tr>
<td>5,506,950</td>
<td>09-April-1996</td>
</tr>
<tr>
<td>4,430,772</td>
<td>27-June-1995</td>
</tr>
<tr>
<td>8,850,535</td>
<td>15-December-1998</td>
</tr>
<tr>
<td>5,557,176</td>
<td>09-November-1996</td>
</tr>
<tr>
<td>5,561,747</td>
<td>01-October-1996</td>
</tr>
</tbody>
</table>

Third-Party Trademarks
Adobe, Acrobat, Distiller, and the Acrobat logo are trademarks of Adobe Systems Incorporated. Advanced ClusterProven, ClusterProven, and the ClusterProven design are trademarks or registered trademarks of International Business Machines Corporation in the United States and other countries and are used under license. IBM Corporation does not warrant and is not responsible for the operation of this software product. AIX is a registered trademark of IBM Corporation. Allegro, Cadence, and Concept are registered trademarks of Cadence Design Systems, Inc. Apple, Mac, Mac OS, and Panther are trademarks or registered trademarks of Apple Computer, Inc. AutoCAD and Autodesk Inventor are registered trademarks of Autodesk, Inc. Baan is a registered trademark of Baan Company. CADAM and CATIA are registered trademarks of Dassault Systemes. COACH is a trademark of CADTRAIN, Inc. CYA, iArchive, HOTBackup, and Virtual StandBy are trademarks or registered trademarks of CYA Technologies, Inc. DOORS is a registered trademark of Telelogic AB. FLEXlm and FLEXnet are registered trademarks of Macrovision Corporation. Geomagic is a registered trademark of Raindrop Geomagic, Inc. EVERSYNC, GROOVE, GROOVEFEST, GROOVE.NET, GROOVE NETWORKS, iGROOVE, PEERWARE, and the interlocking circles logo are trademarks of Groove Networks, Inc. Helix is a trademark of Microcadam, Inc. HOOPS is a trademark of Tech Soft America, Inc. HP-UX is a registered trademark of Hewlett-Packard Company. I-DEAS, Metaphase, Parasolid, SHERPA, Solid Edge, TeamCenter, UG-NX, and Unigraphics are trademarks or registered trademarks of UGS Corp. InstallShield is a registered trademark and service mark of InstallShield Software Corporation in the United States and/or other countries. Intel is a registered trademark of Intel Corporation. IRI is a registered trademark of Silicon Graphics, Inc. I-Run and ISOGEN are registered trademarks of Alias Ltd. LINUX is a registered trademark of Linus Torvalds. MainWin and Mainsoft are trademarks of Mainsoft Corporation. MatrixOne is a trademark of MatrixOne, Inc. Mentor Graphics and Board Station are registered trademarks and 3D Design, AMPLE, and Design Manager are trademarks of Mentor Graphics Corporation. MEDUSA and STHENO are trademarks of CAD Schroer GmbH. Microsoft, Microsoft Project, Windows, the Windows logo, Windows NT, Windows XP, Visual Basic, and the Visual Basic logo are registered trademarks of Microsoft Corporation in the United States and/or other countries. Moldflow is a registered trademark of Moldflow Corporation. Netscape and the Netscape N and Ship's Wheel logos are registered trademarks of Netscape Communications Corporation in the U.S. and other countries. Oracle is a registered trademark of Oracle Corporation. OrbixWeb is a registered trademark of IONA Technologies PLC. PDGS is a registered trademark of Ford Motor Company. RAND is a
Third-Party Technology Information

Certain PTC software products contain licensed third-party technology:

Rational Rose 2000E is copyrighted software of Rational Software Corporation.
RetrievalWare is copyrighted software of Convera Corporation.
VisTools library is copyrighted software of Visual Kinematics, Inc. (VKI) containing confidential trade secret information belonging to VKI.
HOOPS graphics system is a proprietary software product of, and is copyrighted by, Tech Soft America, Inc.
I-Run and ISOGEN are copyrighted software of Alias Ltd.
Xdriver is copyrighted software of 3Dconnexion, Inc, a Logitech International S.A. company.
G-POST is copyrighted software and a registered trademark of Intercim.
VERICUT is copyrighted software and a registered trademark of CGTech.
FLEXnet Publisher is copyrighted software of Macrovision Corporation.
Pro/PLASTIC ADVISOR is powered by Moldflow technology.
MainWin Dedicated Libraries are copyrighted software of Mainsoft Corporation.
DFORMD.DLL is copyrighted software from Compaq Computer Corporation and may not be distributed.
Visual Basic for Applications and Internet Explorer is copyrighted software of Microsoft Corporation.
Parasolid is © UGS Corp.
TECHNOMATIX is copyrighted software and contains proprietary information of Technomatix Technologies Ltd.
TIBCO ActiveEnterprise, TIBCO Designer, TIBCO Enterprise Message Service, TIBCO Rendezvous, TIBCO TurboXML, and TIBCO BusinessWorks are provided by TIBCO Software Inc.
Technology "Powered by Groove" is provided by Groove Networks, Inc.
Technology "Powered by WebEx" is provided by WebEx Communications, Inc.
Oracle 8i run-time, Oracle 9i run-time, and Oracle 10g run-time are Copyright © 2002–2004 Oracle Corporation. Oracle programs provided herein are subject to a restricted use license and can only be used in conjunction with the PTC software they are provided with.
Adobe Acrobat Reader and Adobe Distiller are copyrighted software of Adobe Systems Inc. and
are subject to the Adobe End-User License Agreement as provided by Adobe with those products.

METIS, developed by George Karypis and Vipin Kumar at the University of Minnesota, can be researched at http://www.cs.umn.edu/~karypis/metis. METIS is © 1997 Regents of the University of Minnesota.


Pop-up calendar components Copyright © 1998 Netscape Communications Corporation. All Rights Reserved.

Apache Server, Tomcat, Xalan, Xerces, and Jakarta are technologies developed by, and are copyrighted software of, the Apache Software Foundation (http://www.apache.org) – their use is subject to the terms and limitations at: http://www.apache.org.

UnZip (© 1990-2001 Info-ZIP, All Rights Reserved) is provided “AS IS” and WITHOUT WARRANTY OF ANY KIND. For the complete Info-ZIP license see http://www.info-zip.org/doc/LICENSE.

The Java™ Telnet Applet (StatusPeer.java, TelnetIO.java, TelnetWrapper.java, TimedOutException.java), Copyright © 1996, 97 Mattias L. Jugel, Marcus Meißner, is redistributed under the GNU General Public License. This license is from the original copyright holder and the Applet is provided WITHOUT WARRANTY OF ANY KIND. You may obtain a copy of the source code for the Applet at http://www.mud.de/se/jta (for a charge of no more than the cost of physically performing the source distribution), by sending e-mail to leo@mud.de or marcus@mud.de—you are allowed to choose either distribution method. Said source code is likewise provided under the GNU General Public License.

GTK+ - The GIMP Toolkit is licensed under the GNU Library General Public License (LGPL). You may obtain a copy of the source code at http://www.gtk.org, which is likewise provided under the GNU LGPL.

zlib software Copyright © 1995-2002 Jean-loup Gailly and Mark Adler.

OmniORB is distributed under the terms and conditions of the GNU General Public License and GNU Library General Public License.


Java Port copyright 1998 by Aaron M. Renn (arenn@urbanophile.com), is redistributed under the GNU LGPL. You may obtain a copy of the source code at http://www.urbanophile.com/arenn/hacking/download.html. The source code is likewise provided under the GNU LGPL.

CUP Parser Generator Copyright ©1996-1999 by Scott Hudson, Frank Flannery, C. Scott Ananian–used by permission. The authors and their employers disclaim all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event shall the authors or their employers be liable for any special, indirect or consequential damages, or any damages whatsoever resulting from loss of use, data or profits, whether in an action of contract, negligence or other tortious action arising out of or in connection with the use or performance of this software.

This product may include software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org): Copyright © 1998-2003 The OpenSSL Project. All rights reserved. This product may include cryptographic software written by Eric Young (eay@cryptsoft.com).

ImageMagick software is Copyright © 1999-2005 ImageMagick Studio LLC, a nonprofit organization dedicated to making software imaging solutions freely available. ImageMagick is freely available without charge and provided pursuant to the following license agreement: http://www.imagemagick.org/script/license.php.

Gecko and Mozilla components are subject to the Mozilla Public License Version 1.1 at
Software distributed under the Mozilla Public License (MPL) is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either expressed or implied. See the MPL for the specific language governing rights and limitations.

Mozilla Japanese localization components are subject to the Netscape Public License Version 1.1 (at http://www.mozilla.org/NPL). Software distributed under the Netscape Public License (NPL) is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either expressed or implied (see the NPL for the rights and limitations that are governing different languages). The Original Code is Mozilla Communicator client code, released March 31, 1998 and the Initial Developer of the Original Code is Netscape Communications Corporation. Portions created by Netscape are Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. Contributors: Kazu Yamamoto (kazu@mozilla.gr.jp), Ryoichi Furukawa (furu@mozilla.gr.jp), Tsukasa Maruyama (mal@mozilla.gr.jp), Teiji Matsuba (matsuba@dream.com).

iCal4j is Copyright © 2005, Ben Fortuna, All rights reserved. Redistribution and use of iCal4j in source and binary forms, with or without modification, are permitted provided that the following conditions are met: (i) Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer; (ii) Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution; and (iii) Neither the name of Ben Fortuna nor the names of any other contributors may be used to endorse or promote products derived from this software without specific prior written permission. iCal4j SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Software may contain the Independent JPEG Group's JPEG software. This software is Copyright © 1991-1998, Thomas G. Lane. All Rights Reserved. This software is based in part on the work of the Independent JPEG Group.

Software may contain libpng, Copyright © 2004 Glenn Randers-Pehrson, which is distributed according to the disclaimer and license (as well as the list of Contributing Authors) at http://www.libpng.org/pub/png/src/libpng-LICENSE.txt.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS LEGEND
This document and the software described herein are Commercial Computer Documentation and Software, pursuant to FAR 12.212(a)-(b) (OCT'95) or DFARS 227.7202-1(a) and 227.7202-3(a) (JUN'95), and are provided to the US Government under a limited commercial license only. For procurements predating the above clauses, use, duplication, or disclosure by the Government is subject to the restrictions set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013 (OCT'88) or Commercial Computer Software-Restricted Rights at FAR 52.227-19(c)(1)(2) (JUN'87), as applicable.

Parametric Technology Corporation, 140 Kendrick Street, Needham, MA 02494 USA
# Contents

**About This Guide** .................................................................................. xiii

- Technical Support ....................................................................................... xiii
- Documentation for PTC Products................................................................. xiii
- PTC Documentation Conventions............................................................... xiv

**Types of Customer Service** .................................................................... 1-1

- Identifying the Service You Need ............................................................... 1-2
- Customer Care Center ............................................................................... 1-2
- Technical Support ..................................................................................... 1-3

**Customer Care Center** .......................................................................... 2-1

- Global Maintenance Support ..................................................................... 2-2
- Purchasing a Maintenance Support Program ............................................ 2-2
- Contacting Your Maintenance Support Representative ......................... 2-2
- Choosing a Global Maintenance Support Program .................................. 2-3
- Order Management .................................................................................... 2-5
- Contracts .................................................................................................... 2-5
- Credit and Collections ............................................................................... 2-5
- Distribution ............................................................................................... 2-5
- PTC Global Services ................................................................................ 2-6
  - Training Services .................................................................................... 2-6
  - Implementation Services ........................................................................ 2-6
  - Product Development Consulting Services ....................................... 2-6
Assessment Services ........................................................................................................ 2-7

**License Management** .......................................................................................... 3-1

- Services Provided by License Management .............................................................. 3-2
  - Placing a Software Order ....................................................................................... 3-2
  - Obtaining License Codes for a New Software Order ............................................. 3-3

- Accessing Software License Information ................................................................ 3-3
  - Requesting a Customer Detailed License Report .................................................. 3-3
  - Verifying or Updating Address and Hardware Information .................................... 3-4
  - Requesting a New License Pack ........................................................................... 3-4

- Modifying License Configuration ............................................................................. 3-5

- Accessing Phone Support ....................................................................................... 3-7
  - North America Service ......................................................................................... 3-7
  - Europe and Far East Service .................................................................................. 3-7

- Calling the License Management Department ......................................................... 3-8
  - Preparing for Your Call .......................................................................................... 3-8
  - Following Up Your Call .......................................................................................... 3-9

- Using Additional Methods for Opening a Call ......................................................... 3-9
  - Tracking Calls on the PTC Web Site ..................................................................... 3-9
  - Resolving Your Question ....................................................................................... 3-9
  - Escalating Your Issue ............................................................................................. 3-10

**Technical Support** .............................................................................................. 4-1

- VAR Technical Support ............................................................................................. 4-2
- PTC Technical Support Benefits ............................................................................... 4-2
- PTC Technical Support ISO 9000 Certification ......................................................... 4-2
- PTC Technical Support Feedback Line ...................................................................... 4-3

- Product Retirement and the Support Policy ............................................................... 4-3

**Contacting Technical Support** ............................................................................. 5-1

- Pre-Call Checklist ..................................................................................................... 5-2
- Preparing to Contact Technical Support ................................................................... 5-4
- Opening and Tracking a Call to Technical Support ................................................ 5-4
  - Opening Calls on the PTC Web Site ..................................................................... 5-5
Tracking Calls on the PTC Web Site ................................................................. 5-5
Opening Calls by Telephone or Fax ................................................................. 5-5
Opening Calls by E-Mail .................................................................................. 5-5
Processing Your Technical Support Calls ...................................................... 5-5
Resolving Your Question .................................................................................. 5-6
Software Performance Reports (SPR) ............................................................. 5-7
Escalation of Issues ......................................................................................... 5-7
Understanding Call Priority ............................................................................ 5-9
Understanding Escalation Levels .................................................................... 5-10
Enhancements for Products ............................................................................ 5-11
Submitting an Enhancement Request on the PTC Web Site ......................... 5-12
Tracking Enhancement Requests on the PTC Web Site .................................. 5-12

Sending Additional Data to Technical Support .............................................. 6-1
Gathering the Required Data ........................................................................... 6-2
  CADDS, Optegra, and DIMENSION III ......................................................... 6-2
  Electronic Design Entry (EDE) ...................................................................... 6-2
  Info*Engine .................................................................................................... 6-2
  DIVISION ProductView .............................................................................. 6-2
  Pro/ENGINEER ............................................................................................. 6-3
  Pro/INTRALINK ............................................................................................. 6-4
  Pro/ENGINEER Simulation (formerly Mechanica) ......................................... 6-4
  Routed Systems Designer ............................................................................ 6-5
  Windchill Import and Export ........................................................................ 6-6
  Windchill Information Modeler ...................................................................... 6-6
  Windchill Installation and Configuration ....................................................... 6-7
  Windchill Visualization .................................................................................. 6-7
Sending Multiple Files ..................................................................................... 6-8
  On a UNIX Platform ..................................................................................... 6-8
  On a Windows Platform ................................................................................ 6-9
Securing Data for Transfer ............................................................................. 6-9
  Handling NDA Data ..................................................................................... 6-9
  Handling ITAR Data .................................................................................... 6-10
Sending the Data ............................................................................................. 6-11
  Sending the Data on Floppy Disk, Zip Disk, CD, or Tape Media .................. 6-11
  Sending the Data Using the PTC File Transfer Protocol (FTP) Server ........ 6-11
Sending Data by E-Mail.................................................................................................................. 6-13
Sending Data Using Call Logger and Call Tracker............................................................... 6-14

**Windchill Solution Technical Support Guidelines** ............................................. 7-1

Overview ......................................................................................................................... 7-2
License Agreement and Legal Obligations ...................................................................... 7-2
Customization.................................................................................................................... 7-2
Requirements for Customization .................................................................................. 7-3
Interaction with Third-Party Products ........................................................................ 7-3
Support of End Users .................................................................................................... 7-3
Error Tracking ................................................................................................................ 7-4

Supported Configurations ............................................................................................... 7-4

Supported Windchill Solution Releases ........................................................................ 7-5
Multiple Windchill Instances ...................................................................................... 7-5
Support of Dataloader Tools ....................................................................................... 7-6
Support of Windchill Customization .......................................................................... 7-6
Support for Java Programming .................................................................................. 7-7
Information Modeler ...................................................................................................... 7-7
Programming Styles ...................................................................................................... 7-7
Customer Source Code Examples .............................................................................. 7-7

Supported and Nonsupported Usage of the API ............................................................... 7-7
Decompiling Source Code ............................................................................................ 7-8
Supported Languages ..................................................................................................... 7-8
Modification of Existing Windchill Classes .................................................................. 7-8
Windchill Classes ........................................................................................................ 7-9
Windchill Class Extensions .......................................................................................... 7-9
JavaScript ...................................................................................................................... 7-9

Support of Third-Party Products .................................................................................. 7-9
Installation .................................................................................................................... 7-10
Configuration ................................................................................................................. 7-10
Software Errors ............................................................................................................... 7-10
Supported and Nonsupported Third-Party Issues .......................................................... 7-10
Support Contracts with Third-Party Vendors ................................................................. 7-12

Support for PTC PLM On Demand ............................................................................. 7-13
Using PLM On Demand as a Super User ...................................................................... 7-14
Following Up a Logged Call for PLM On Demand .......................................................... 7-14
Windchill Maintenance and Patches ................................................................. 7-15

Technical Support Web Site ................................................................. 8-1
   Inside the PTC Technical Support Web Site ........................................ 8-2
   24-Hour Access to Calls, SPRs, and TANs .......................................... 8-4
   Connecting to the PTC Technical Support Web Site ..................... 8-5
   PTC Online Accounts ......................................................................... 8-5

Index
About This Guide

*PTC Customer Service Guide* describes services provided through Technical Support, the Customer Care Center (including License Management, Maintenance Support, Training, and Consulting), and the PTC Web site. It also provides general information on how to contact PTC (Parametric Technology Corporation).

**Technical Support**

Contact PTC Technical Support via the PTC Web site, phone, fax, or e-mail if you encounter problems. For information on how to contact PTC Technical Support, see Opening and Tracking a Call to Technical Support in this guide. This *PTC Customer Service Guide* can also be found on the PTC Web site at:

[www.ptc.com/support/cs_guide/index.htm](http://www.ptc.com/support/cs_guide/index.htm)

You must have a Service Contract Number (SCN) before you can receive technical support. If you do not have a number, contact PTC Maintenance Department by calling the customer care line (listed in the back of this guide) or by using the online Customer Care Call Logger at

[www.ptc.com/appserver/cs/cust_care_call_logger/CustomerCareCallLogger.jsp](http://www.ptc.com/appserver/cs/cust_care_call_logger/CustomerCareCallLogger.jsp)

**Documentation for PTC Products**

PTC provides documentation in the following forms:

- Context-sensitive Help
- PDF books

When your PTC software has been installed, you can right-click on any menu or dialog box to get Help. You can also choose a command from the Help menu.

All books are available in HTML and PDF formats on the documentation CD-ROM. You can view HTML books with your Internet browser. To view and print PDF books, you must have the Acrobat Reader installed.

PTC welcomes your suggestions and comments on its documentation. You can send feedback electronically to doc-webhelp@ptc.com.

**PTC Documentation Conventions**

PTC documentation uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Item</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Menu paths, dialog box options, buttons, and other selectable elements from the user interface.</td>
<td>Click <strong>File &gt; Save</strong>. <strong>Assignee</strong> check box. Click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td>User input, system messages, directories, and file names.</td>
<td>Processing completed.</td>
</tr>
<tr>
<td>Courier with less-</td>
<td>Variables for which the user substitutes an appropriate value</td>
<td>output=&lt;LOADPOINT&gt;</td>
</tr>
<tr>
<td>than and greater-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>than symbols(&lt;&gt;))</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Welcome to Parametric Technology Corporation (PTC) and to PTC Customer Service. PTC provides a number of resources and services to help you resolve your questions and concerns quickly and efficiently and to optimize your productivity with PTC software. This chapter identifies the different types of customer service PTC offers and tells you where each type is described more fully.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifying the Service You Need</td>
<td>1-2</td>
</tr>
</tbody>
</table>
What Is PTC Customer Service?

Customers can contact the Customer Care Center or Technical Support by phone or e-mail, or through our Web tools. PTC provides customer service in two forms:

Customer Care—Assistance with administrative, licensing, training, and consulting issues. Customer Care is described in chapters 2-3.

Technical Support—Assistance by engineers trained in solving technical problems with PTC software. Technical Support is described in chapters 4-8.

Identifying the Service You Need

Before you call PTC for customer service, determine whether you need the Customer Care Center or Technical Support. See the previous descriptions. Then, from one of the next two tables, choose the group best suited to serve your needs. The listed chapters describe the type of service provided by each group and the method to contact each group.

Customer Care Center

<table>
<thead>
<tr>
<th>PTC Group</th>
<th>Task</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance Support</td>
<td>To renew or modify your Maintenance Support contract or to ask questions about your entitlement to software updates and technical support</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Order Management</td>
<td>To determine the status of purchase orders or evaluations</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Contracts</td>
<td>To request a license transfer</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Credit and Collections</td>
<td>To pay outstanding invoices</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Distribution</td>
<td>To order updates to CDs and to track shipments</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Global Services (Education and Consulting)</td>
<td>To obtain training, educational materials or consulting services</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>PTC Group</td>
<td>Task</td>
<td>Chapter</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>License Management</td>
<td>To obtain license codes for PTC software that you have purchased or to update customer or software configuration information in the PTC database</td>
<td>Chapter 3</td>
</tr>
</tbody>
</table>

**Technical Support**

<table>
<thead>
<tr>
<th>PTC Group</th>
<th>Task</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR Technical Support</td>
<td>To solve technical problems or ask questions about the usage of PTC software (for customers supported by a VAR)</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Technical Support</td>
<td>To solve technical problems or to ask questions about the usage of PTC software</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Technical Support</td>
<td>To provide comments or suggestions to Technical Support management about services or to ask questions or to raise issues about service procedures</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Technical Support</td>
<td>To prepare to contact Technical Support for help on your issue</td>
<td>Chapter 5</td>
</tr>
<tr>
<td>Technical Support</td>
<td>To send additional data to a Technical Support Engineer to replicate and solve your problem</td>
<td>Chapter 6</td>
</tr>
<tr>
<td>Windchill Technical Support</td>
<td>To solve technical problems or to ask questions about the use of Windchill software</td>
<td>Chapter 7</td>
</tr>
<tr>
<td>Technical Support</td>
<td>To access the Technical Support knowledge base, access certain user documentation, or use the Technical Support Web tools</td>
<td>Chapter 8</td>
</tr>
</tbody>
</table>
This chapter provides an overview of what the Customer Care Center can offer. License Management is described in the next chapter, and Technical Support is described in separate chapters. The customer service departments—Technical Support, License Management, Maintenance Support, Order Management, Distribution, and Global Services—in North America and Europe are accessible through the Customer Care Center.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Maintenance Support</td>
<td>2-2</td>
</tr>
<tr>
<td>Order Management</td>
<td>2-5</td>
</tr>
<tr>
<td>Contracts</td>
<td>2-5</td>
</tr>
<tr>
<td>Credit and Collections</td>
<td>2-5</td>
</tr>
<tr>
<td>Distribution</td>
<td>2-5</td>
</tr>
<tr>
<td>PTC Global Services</td>
<td>2-6</td>
</tr>
</tbody>
</table>
Global Maintenance Support

The Maintenance Support program at PTC is designed to help you operate at peak performance. The programs provide access to the latest releases of PTC software, telephone support, Web-based technical support, documents, and learning tools.

Purchasing a Maintenance Support Program

To sign up for a Maintenance Support program, contact a Maintenance Support representative as described in the next section. If you have a Maintenance Support program, one to two months before your program expires, you will receive a quote for a Maintenance Support contract to cover your purchased software. Your Maintenance Support representative will contact you shortly thereafter to ensure that you have received the quote from PTC and to answer any questions you may have. Generally, the end dates of all items quoted are made coterminous. Let your Maintenance Support representative know if you prefer a common end date for budgeting or other reasons. PTC quotes on an annual basis.

Note: If you choose to purchase a Maintenance Support program for a license for which you have previously declined support, you must pay both the current and the retroactive Maintenance Support fees associated with that license. Otherwise, you must repurchase the software.

When you are ready to submit a payment, you can choose one of three methods:

- **Purchase order**—Fax a purchase order (not a purchase requisition) to your Maintenance Support representative. This method ensures the fastest service.

- **Credit card**—Fax a completed copy of our credit card request form to your Maintenance Support representative.

- **Check or purchase order**—Mail a check or purchase order (not a purchase requisition) to your Maintenance Support representative.

Contacting Your Maintenance Support Representative

Customers worldwide can call the Software Maintenance Support Representative for their region at the phone number listed at the end of this guide. You can also obtain contact information and details at [www.ptc.com/support/maintenance/index.htm](http://www.ptc.com/support/maintenance/index.htm).
Choosing a Global Maintenance Support Program

PTC recognizes your need to maximize productivity with PTC software. Therefore, PTC offers a Gold Support Package as our standard Maintenance Support program. The gold level provides the most comprehensive support program in the industry and a choice of premium options.

If you use Arbortext products, see the Arbortext Technical Support Guide at www.arbortext.com/support/support.html.

Maintenance Support Packages

<table>
<thead>
<tr>
<th>Gold Support</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• 24 hours x 5 day telephone support (M-F)</td>
<td></td>
</tr>
<tr>
<td>• 2-hour response times (1-hour response times for Windchill products)</td>
<td></td>
</tr>
<tr>
<td>• Software fixes and automatic shipments of new releases</td>
<td></td>
</tr>
<tr>
<td>• Web-based support, learning tools, knowledge database</td>
<td></td>
</tr>
<tr>
<td>• Eligibility for discounted software upgrade packages</td>
<td></td>
</tr>
<tr>
<td>• Customer Configuration Profile Database</td>
<td></td>
</tr>
<tr>
<td>• Live and recorded interactive “Tips and Techniques” sessions</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enterprise Support</th>
<th>Premium Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 24 hours x 7 day telephone support with 1-hour response time</td>
<td>• Dedicated Technical Support Engineer</td>
</tr>
<tr>
<td>• Priority shipment of new versions of releases</td>
<td>• Technical Support Account Manager</td>
</tr>
<tr>
<td>• Technical Support Account Manager (for accounts of greater than $500K maintenance per year)</td>
<td>• Weekend Support</td>
</tr>
<tr>
<td>• Software Upgrade Installation Management (Pro/ENGINEER products only for accounts of greater than $500K maintenance per year)</td>
<td>• Software Upgrade Installation Management (Pro/ENGINEER products only)</td>
</tr>
</tbody>
</table>

Maintenance Support Features and Added Values

For information on these plans beyond that which follows, visit Global Maintenance Support at www.ptc.com/support/maintenance/index.htm. Added values are indicated by a checkmark (✓).
Investment Protection and Enhancement

- Periodic software enhancements
- Ongoing fixes and performance upgrades
- Free software plug-ins and parts catalog
- Quality software development CMMI compliant
- Discounts on software package upgrades

Reliable and Consistent Technical Support

- Responsive Phone Support from +200 engineers using a common database
- Remote diagnostics and resolution of problems from the desktop
- ISO 9001-2000 certified process worldwide
- Multiple languages spoken in multiple time zones
- Standard escalation procedure
- Premium Support Options
  - 24x7 phone support
  - Technical Support Account Managers
  - Weekend installation support
  - Dedicated Technical Support Engineers
- Comprehensive customer service guide

Support and Productivity Web Tools 24x7

- Call Logger and Call Tracker
- Online tracking of Software Performance Reports (SPRs)
- Online software downloads
- Document Knowledge Database of 25,000+ items
  - Technical Points of Interest (TPIs)
  - Technical Application Notes (TANs)
- Natural language search and personalized alerts
- Suggested Techniques, FAQs, and Help documents
✓ Update Advisor of fixes made in new releases
✓ New product release reference documents
✓ Customer Configuration Profile
✓ Product Enhancement Request tool
✓ Business Asset Summary tool
✓ License Configuration and Management tools
✓ Live “Tips and Techniques” Web casts and “How to” videos

Upgrading to the Enterprise Support Package

For 24x7 telephone support and other special features for mission-critical applications, consider an upgrade to the Enterprise Support Package. Qualified customers receive dedicated support for priority issues and software upgrades. This package keeps your team as productive as possible. Contact your Maintenance Support Representative at the phone number for your region in the back of this guide.

Order Management

The Order Management group can tell you the status of purchase orders or of evaluations after your Sales Representative submits them.

Contracts

The Contracts group handles license transfers and name changes. If your company has been acquired or has acquired another company, the Contracts group will assist you in initiating a license transfer. If your company has changed names, the Contracts group can update this information at PTC.

Credit and Collections

The Credit and Collections group will assist you in questions regarding or in paying outstanding invoices and in checking the status of payments.

Distribution

The Distribution group handles orders for software updates and can assist you in tracking shipments.
PTC Global Services

PTC Global Services provides solutions to help you execute your product development strategy and to get the most value out of your investment in PTC technology. The range of services includes Training Services, Implementation Services, Product Development Consulting Services, and Assessment Services.

Training Services

PTC delivers a blend of high quality training designed to help users realize higher levels of productivity in a shorter timeframe. The following training services are available:

**Training Courses**—Unique technological insights not found elsewhere and interactive content in three formats:

- Classroom: Interactive training is designed and delivered by the PTC technology experts.
- Virtual Classroom: Instructor-led training over the Internet provides the benefits of classroom training without the travel expense.
- Web-based training: Self-paced training includes the same comprehensive content as other courses (lecture, demonstrations, hands-on exercises, and assessments)

**Corporate Learning Programs**—Personalized, role-based training curricula designed to meet specific needs

**Pro/FICIENCY Tool**—Performance-based assessments to evaluate proficiency levels to identify learning needs

For more information on training offerings, course schedules, or to register for a course, visit [www.ptc.com/services/training](http://www.ptc.com/services/training).

Implementation Services

The Implementation Services deploy PTC technology to accelerate adoption of products and releases while minimizing disruption. Prepackaged, fixed-price services leverage the collective expertise from thousands of engagements to shorten learning curves and increase adoption rates for new technology.

Product Development Consulting Services

Product Development Consulting Services help you better leverage technology through high impact improvements in your product
development processes. With over 20 years of product development experience and in-depth product knowledge, PTC understands best practices in the areas of engineering, collaboration, and other industry-specific processes and can help you implement them.

**Assessment Services**

Assessment Services examine your current product development environment including people, processes, and technology adoption to identify the highest value opportunities. PTC then delivers a personalized deployment strategy and business case outlining the benefits of the deployment.
The PTC License Management (LM) department generates and distributes license codes to PTC customers and maintains the related information, such as hardware and address information, in the PTC database. This chapter presents details on the services provided by the LM department. Many of the services provided are accessible on the PTC Web site, which allows you to access your own licensing information 24 hours a day.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Services Provided by License Management</td>
<td>3-2</td>
</tr>
<tr>
<td>Accessing Software License Information</td>
<td>3-3</td>
</tr>
<tr>
<td>Modifying License Configuration</td>
<td>3-5</td>
</tr>
<tr>
<td>Using PTC Web Tools</td>
<td>3-6</td>
</tr>
<tr>
<td>Accessing Phone Support</td>
<td>3-7</td>
</tr>
<tr>
<td>Calling the License Management Department</td>
<td>3-8</td>
</tr>
<tr>
<td>Using Additional Methods for Opening a Call</td>
<td>3-9</td>
</tr>
</tbody>
</table>
Services Provided by License Management

PTC License Management (LM) provides the following services for obtaining and managing your PTC software products and licenses:

- Codes for new software orders.
- Access to PTC software license information, including the ability to request a current license pack, access or modify current address and contact information, and request a Customer Detail Report.
- Ability to modify existing license configurations, including removing and reinstalling software when replacing obsolete machines, consolidating licenses to a single server, and moving options from one license to another.

The PTC LM Web tools provide the most efficient management of your licenses at [www.ptc.com/olm/index.htm](http://www.ptc.com/olm/index.htm). With the online tools you can perform almost every license management operation without calling a License Management representative. You can also contact License Management by one of the following methods:

- Call the Customer Care Center or the License Management office at the number listed in the Worldwide Contact Information at the back of this guide.
- Log a call via the Customer Care Call Logger at [www.ptc.com/support/new_customer_care_center.htm](http://www.ptc.com/support/new_customer_care_center.htm).

The PTC process for license distribution allows you to obtain the desired license configurations during the installation process. The processes for placing a software order and obtaining license codes for a new software order follow.

Placing a Software Order

The process of placing a software order with a PTC sales representative and the shipping of the order is as follows:

- Place an order for new software with a PTC sales representative or authorized reseller. No hardware or installation information is provided with the software order.
- The order is entered into the PTC system and shipped to the designated address.
- Upon shipment, the “Ship To” contact on the order receives by e-mail a Shipment Confirmation Letter. This letter describes the
contents of the order and provides the Sales Order Number (SON) you must use when you request a license code.

Obtaining License Codes for a New Software Order

PTC provides access your licenses online after you have received your Shipment Confirmation Letter and CD shipment. Use the following process to obtain your license codes:

1. Locate your Sales Order Number (SON) on the Shipment Confirmation Letter or on the packing slip.

2. Gather the hardware information (CPU ID) by starting the installation process or as outlined in Determining a Machine’s CPU ID on the PTC Web site at www.ptc.com/olm/ist1071/ist1071.htm.


4. Use the SON to access all of the products on that order.

5. Select the products for installation and specify the cpu_id and hardware information. Within one hour, a license pack is sent by e-mail to the specified address.

Accessing Software License Information

PTC provides access to current software license codes, address information, and all required license details.

Requesting a Customer Detailed License Report

PTC customers can request a Customer Detail Report, which lists the license information for each installation site.

<table>
<thead>
<tr>
<th>Customer Number</th>
<th>Order Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>Release</td>
</tr>
<tr>
<td>Sales Order Number (SON)</td>
<td>Quantity</td>
</tr>
<tr>
<td>Purchase Order Number (PO)</td>
<td>Locked/Floating</td>
</tr>
<tr>
<td>Configuration ID or IDs</td>
<td>Maintenance Support Status</td>
</tr>
<tr>
<td>Install Number</td>
<td>Product Type</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Service Contract Number (SCN)</td>
</tr>
<tr>
<td>CPU ID (Host ID)</td>
<td>Contract Status</td>
</tr>
<tr>
<td>Host Name</td>
<td>Contract End Date</td>
</tr>
<tr>
<td>Host Type</td>
<td>Contract Negotiation Date</td>
</tr>
<tr>
<td>Platform</td>
<td>Site</td>
</tr>
</tbody>
</table>
Verifying or Updating Address and Hardware Information

PTC customers must keep their hardware and address information as accurate and as up-to-date as possible. PTC sends information to businesses based on hardware-specific issues and contacts businesses with important information regarding Maintenance Support contracts, software updates, license information, and Maintenance Support releases.

To verify or update your address or hardware information:

1. Obtain the CPU ID or Configuration ID and Installation Site ID. See your Customer Detail Report or an existing license pack.


The PTC Web site allows you to specify a new installation address and, if necessary, a different Maintenance Support shipping address. All information can be modified, including the contact name.

A Web account with licensing privileges is required to obtain access to update hardware information. To obtain a Web account, sign up online at www.ptc.com/appserver/common/account/basic.jsp.

Requesting a New License Pack

PTC Customers can request a current license pack. A license pack is convenient for businesses that must reconfigure their license or review their current licensing configurations. The license pack typically has all required information to complete any machine or software reconfiguration.

To request a new license pack:

1. Obtain one of the following pieces of information:
   
   – Service Contract Number (SCN)
   – Sales Order Number (SON)
   – Host ID (cpu_id)
– Site ID (installation site number)

– Configuration ID

This information can be found on the Customer Detail Report, in your currently installed software, or other administrative information sent to your customer site.


3. Enter the required information. The appropriate license pack is then sent by e-mail to the address specified in your Web account.

A Web account with licensing privileges is required to access this site. Sign up at www.ptc.com/appserver/common/account/basic.jsp for an account.

Modifying License Configuration

PTC customers can modify an existing license configurations, including removing and reinstalling their licenses when replacing machines, consolidating licenses to a single server, or moving options from one license to another. In a removal and reinstallation, all products and licenses associated with a machine can be removed and associated with another machine. This reconfiguration is most commonly performed when replacing a machine.

With the Online Reconfigure Software tool, you can move Config IDs to different machines, consolidate licenses to single server from triad servers, or break a triad server into single server.

To reconfigure PTC software licenses to obtain the desired licensing scheme:

1. Obtain the existing CPU ID and new CPU ID. You can find this information in your license pack, or you can extract it from the Customer Detail Report.


3. Enter the appropriate information and submit the request. A new PTC License Pack is sent by e-mail to the address specified in your Web account.

A Web account with licensing privileges is required for access to this site. Sign up at www.ptc.com/appserver/common/account/basic.jsp for an account.
Using PTC Web Tools

PTC License Management Web tools provide a complete set of services for configuring, maintaining, and tracking your PTC software licenses. Continuous improvement of the tools ensures the most complete and efficient management of the information associated with your PTC software licenses and license requests. Review the tools at www.ptc.com/olm/index.htm for more details on your specific license management needs. The PTC License Management Web tools will process your request and provide you with a call number for tracking purposes. That call number can be used to further investigate the request you made through the Web tools.

License Management Privilege Levels

PTC has enhanced the License Management Web tools by adding additional security and providing businesses with increased control over their licensing information with the introduction of the License Management Privilege Levels. The privilege levels limit access to the LM Web tools and grant businesses the ability to define the privilege levels within their organizations.

Three privilege levels have been created—Supervisor, Licensing, and Reporting:

- **LM Supervisor Privileges**—Authorizes an individual to define the LM Privileges for everyone within the user's company. The LM Supervisor Privilege is only for managing the privilege levels of the company's users. There should be more than one individual at a company with LM Supervisor Privileges.

- **LM Licensing Privileges**—Allows editing capabilities for the user to manipulate their license information, such as installing new licenses, moving existing licenses and updating address or contact information. This privilege level does not include the LM Reporting Privileges.

- **LM Reporting Privileges**—Provides view-only capabilities with access to the LM Reports (Customer Detail Reports) and the ability to retrieve their existing license packs.

By default, all customer contacts have access to all of the LM Web tools. Once a supervisor has been assigned, the supervisor then has the ability and responsibility to define the privilege levels for the rest of the company. The existing privileges for the other customer contacts will remain in place until the supervisor removes this access. If someone without the appropriate LM privilege tries to use a Web tool, he or she will be directed to contact the LM Supervisor at his or her company.
License Simplification

License simplification provides an opportunity to consolidate PTC licensed products under one Service Contract Number (SCN) per CPU. Consolidated licences increase the flexibility to configure licenses while also minimizing the number of SCNs for a site.

To receive the latest license pack required to run Pro/ENGINEER, you must perform license simplification, if you have not already done so. Thereafter, a new license pack for Pro/ENGINEER Wildfire 3.0 (version 27) will be sent to you by electronic mail.

For additional information on license simplification, please go to:

- License Simplification FAQ
  www.ptc.com/olm/ls_faq
- License Simplification Overview and License Conversion Webcast
  www25.placeware.com/cc/ptc/view?id=8010&pw

Accessing Phone Support

In addition to Web tools, PTC provides phone support for license management requests.

North America Service

For license management services in North America, call the Customer Care Center at the number listed in the Worldwide Contact Information at the back of this guide.

Europe and Far East Service

For license management services in Europe and the Far East, contact the appropriate PTC office by dialing one of the telephone numbers listed in the Worldwide Contact Information at the back of this guide. A complete list of License Management contact information is on the PTC Web site at www.ptc.com/olm/contacts.htm.

License Management services are located in the following offices:

- Munich, Germany
- Vitrolles, France
• Tokyo, Japan
• Hong Kong, People’s Republic of China

Calling the License Management Department

You can call the License Management department to make product configuration–related requests or license management requests, or to follow up a previous call. If you prefer, you can open calls by fax or e-mail instead. See Using Additional Methods for Opening a Call later in this chapter.

Preparing for Your Call

Before you make your call to License Management, gather critical information for the LM representative. Preparing this information in advance ensures a quicker and more efficient session.

Personal Information

The License Management representative will ask you for the following information to log a call:

• SCN (Service Contract Number) or SON (Sales Order Number)
• Priority of the issue:
  – Extremely critical—Work stopped
  – Critical—Work severely impacted
  – Urgent—Work impacted
  – Noncritical—Work unimpacted

General Information

The LM representative will ask you for the following hardware and software information needed to process your request:

• License Information
  – SON for a newly purchased license.
  – Configuration ID or Service Contract Number for an existing license.
• Address Information
  – Installation Address—Physical location of your PTC license server or client machines running PTC software.
- Contact Information—Name, e-mail address, and telephone and fax numbers for all shipping, billing, administrative, and technical contacts.

- Hardware Information
  - License server or servers for floating licenses and floating optional modules.
  - Independent workstation or workstations for locked licenses.

Following Up Your Call
To follow up on an issue that has been logged, give the number you were assigned for the call, for example, C1234567, to the Customer Service operator. Refer to that number on any correspondence to the License Management department.

For further information, refer to the Support area of the PTC Web site at www.ptc.com/support/index.htm. This Web site contains answers to frequently asked questions, as well as links to portions of the Technical Support Web site.

Using Additional Methods for Opening a Call
Calls can be logged via the Customer Care Call logger located at www.ptc.com/support/new_customer_care_center.htm.

Tracking Calls on the PTC Web Site
You can also use the PTC Web site to track your License Management calls by using Call Tracker located in the Technical Support section of the PTC Web site. This application allows you to view calls placed by your company to PTC Customer Service. Call Tracker provides searching, tracking, and sorting capabilities. It also allows you to add your own comments to a call. When comments are added, the LM representative assigned to your call is notified automatically.

Resolving Your Question
A PTC License Management representative will work with you to resolve your question to your satisfaction. Have the information outlined in Calling the License Management Department in this chapter available when you place your call, so the LM representative can provide more efficient service.

When the LM representative sends the required software codes or notifies you that a request has been sent, the status of the call is
changed to “Resolved.” Use the resolved call number for reference purposes only.

**Note:** If you have a new license management issue to report, do not refer to a resolved call number. Instead, use the LM Web Tools or call License Management directly.

If the LM representative determines that more specific information is required to resolve your issue, please include your call number, along with any additional information requested, in all correspondence to License Management.

**Escalating Your Issue**

Issues are prioritized when you first contact the License Management department. However, the priority of an issue may change during its resolution. To escalate the priority of an issue at any time during the resolution process, perform the following steps:

1. Contact the LM department. Identify the issue using its unique call number and ask to speak to the LM representative assigned to your call.

2. If that LM representative is unavailable, you may escalate an issue by requesting to speak with the LM representative’s direct supervisor (group leader).

3. If you are unable to escalate an issue through either the LM representative or the representative’s group leader, ask to speak to a section manager or manger.
PTC Technical Support provides assistance to customers in the technical aspects of using PTC software and in solving any problems that arise. This chapter gives an overview of PTC Technical Support.

**Topic** | **Page**
---|---
VAR Technical Support | 4-2
PTC Technical Support Benefits | 4-2
PTC Technical Support ISO 9000 Certification | 4-2
PTC Technical Support Feedback Line | 4-3
Product Retirement and the Support Policy | 4-3
VAR Technical Support

PTC participates in partnerships with various value-added resellers (VARs) around the world to help better serve PTC software product users. Some small enterprise businesses within North America and Europe now obtain software sales and support through these VARs. For more information on the services offered by VARs and to identify the VARs in your area, see www.ptc.com/partners/drp/index.htm.

PTC Technical Support Benefits

PTC Technical Support offers the following benefits:

- Scalable support offerings to fit each customer's individual needs
- 24-hour, 7-day-a-week access to our expanded and enhanced Web-based tools and services, as well as easy-to-use online purchasing services
- Worldwide language support
- Focus on continuous improvement and quality monitoring demonstrated through our global ISO 9000 certification
- Multiple channels for direct customer communication—electronic, phone, feedback, surveys—whichever is most convenient

For more details on the benefits of Technical Support, see www.ptc.com/support/maintenance/cs_benefits.htm. At this site, you can read more about the different levels of support.

PTC Technical Support ISO 9000 Certification

All eight PTC Technical Support offices worldwide are certified to ISO 9000 standards. This certification is an indication of our performance as a world-class support organization. These standards promote consistent service, continuous self-improvement, and a focus on customer satisfaction. The U.S. License Management organization is also certified.

Successful certification means that all PTC Technical Support personnel adhere to a single set of carefully constructed processes and procedures in accordance with an internationally recognized standard that is validated by independent certification agencies. As a result, all customers of PTC Technical Support benefit from the same quality of support, no matter which call center is contacted.

**PTC Technical Support Feedback Line**

PTC Technical Support would like to hear from you. If you need help with a technical problem, licensing, Maintenance Support contracts, training, or consulting, contact the appropriate group as described in this chapter. If you have comments, suggestions, or concerns regarding the services provided by PTC Technical Support, contact our Technical Support Feedback Line. The feedback line offers direct access to PTC Technical Support management. For more information on how to contact the PTC Technical Support Feedback Line, visit the PTC Web site at [www.ptc.com/cs/doc/feedback_nums.htm](http://www.ptc.com/cs/doc/feedback_nums.htm) and see the Worldwide Contact Information at the back of this guide.

**Product Retirement and the Support Policy**

The dates for the conversion of PTC products to limited and discontinued support and the related policies are in the PTC Product Calendar at [www.ptc.com/cs/doc/pds_calendar.pdf](http://www.ptc.com/cs/doc/pds_calendar.pdf).
The most important aspect of your relationship with PTC Technical Support is your ability to contact a technical support engineer and, if possible, to troubleshoot your problems and solve them by yourself. When you contact PTC Technical Support, your call is handled according to its content and your geographic location. This chapter describes the process of contacting Technical Support and obtaining help on your issue.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Call Checklist</td>
<td>5-2</td>
</tr>
<tr>
<td>Preparing to Contact Technical Support</td>
<td>5-4</td>
</tr>
<tr>
<td>Opening and Tracking a Call to Technical Support</td>
<td>5-4</td>
</tr>
<tr>
<td>Resolving Your Question</td>
<td>5-6</td>
</tr>
<tr>
<td>Enhancements for Products</td>
<td>5-11</td>
</tr>
</tbody>
</table>
Pre-Call Checklist

Before you contact Technical Support, troubleshoot your issue by following the steps in the pre-call checklist:

1. See the Technical Support page of the PTC Web site at www.ptc.com/support/support.htm. This Web site contains thousands of technical documents, including:

   - **Suggested Techniques**—Recommended approaches to common tasks and descriptions of new functionality.

   - **TANs (Technical Application Notes)** — Documents that describe specific technical issues with PTC products. TANs generally include workarounds and anticipated software corrections.

   - **TPIs (Technical Points of Interest)** — Technical tips not necessarily associated with a particular release of a PTC product.

   - **Product Help** — Online access to the product’s Help system.

2. Read the appropriate documentation to verify that you used the correct procedure to achieve your intended result.

3. Determine whether you can reproduce the issue by performing the same procedure again, using the minimum number of steps.

4. Determine whether the issue also occurs in a newly created or a simpler model or object.

5. If you cannot solve the problem with the previous operations, record the following information before calling Technical Support:

   - The environment in which the problem occurs, including the product (for example, Pro/ENGINEER, Simulation, Pro/INTRALINK, CADDS 5, Windchill, Optegra), module, or mode (for example, Detail, Assembly, Part, Structural and Thermal Simulation, Explicit), and menu selections

   - Your hardware type and model, operating system version, amount of RAM, and swap space

   - Any messages that appear in the message or start window

   - Your software release, license version, and Service Contract Number (SCN)
To determine a release and version, see the following table.

<table>
<thead>
<tr>
<th>Product</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CADDS 5</td>
<td>Click and hold the CADDS 5 logo.</td>
</tr>
<tr>
<td>DIVISION ProductView</td>
<td>Click Help &gt; About ProductView.</td>
</tr>
<tr>
<td>Electronic Design Entry (EDE)</td>
<td>View the listing at the top of the application framework.</td>
</tr>
<tr>
<td>EPD.Connect</td>
<td>Click HELP &gt; About EPD.Connect.</td>
</tr>
<tr>
<td>Optegra Vault (UNIX)</td>
<td>Use the UNIX command: more ${EPD_HOME}/data/edmvers.</td>
</tr>
<tr>
<td>Optegra Vault (Windows)</td>
<td>Use the Registry Editor: Regedit hkey_local_machine Software, Computervision, Vault server.</td>
</tr>
<tr>
<td>Pro/ENGINEER</td>
<td>Click Help &gt; Technical Support Info.</td>
</tr>
<tr>
<td>Pro/INTRALINK</td>
<td>Click HELP &gt; About.</td>
</tr>
<tr>
<td>Routed Systems Designer</td>
<td>Click Help &gt; On Version.</td>
</tr>
<tr>
<td>Structural and Thermal</td>
<td>Click Help &gt; Technical Support Info.</td>
</tr>
<tr>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>Windchill DynamicDesignLink</td>
<td>Click About &lt;Product Name&gt;, where &lt;Product Name&gt; is the name of a Windchill Solution.</td>
</tr>
<tr>
<td>Windchill PDMLink</td>
<td></td>
</tr>
<tr>
<td>Windchill ProjectLink</td>
<td></td>
</tr>
<tr>
<td>Windchill PartsLink</td>
<td>Browse to the server machine folder &lt;PartsLink loadpoint&gt;\version.</td>
</tr>
<tr>
<td>Windchill Visualization</td>
<td>Click About &lt;Product Name&gt;, where &lt;Product Name&gt; is the name of a Windchill Solution.</td>
</tr>
<tr>
<td>Windchill ProductView</td>
<td>Click About &lt;Product Name&gt;, where &lt;Product Name&gt; is the name of a Windchill Solution.</td>
</tr>
</tbody>
</table>
Preparing to Contact Technical Support

Before making your call to Technical Support, you must gather some critical information for the technical support engineer. Preparing this information before you make the call will ensure a quicker and more efficient resolution. The technical support engineer will ask you for the following information to log a call:

- PTC Service Contract Number (SCN) to verify your entitlement to receive technical support. Please have the number before you contact Technical Support.
- Your name
- Your telephone number
- PTC product (module) name
- Priority of the issue:
  - **Enterprise Down**—A production enterprise system is down.
  - **Extremely Critical**—Represents a work stoppage that does not affect the entire enterprise
  - **Critical**—Work is severely impacted and a solution must be found quickly
  - **Urgent**—Work impacted but not significantly
  - **Not Critical**—Work is slightly impacted but can easily be worked around
- The results of the pre-call checklist.

For a follow up of a logged call, give the assigned call number, for example, C1234567, to the Technical Support operator. Refer to that number on any correspondence to the Technical Support department about the call. You can also track the status of a call or contact a technical support engineer by adding a comment to a call using Call Tracker on the PTC Web site.

Opening and Tracking a Call to Technical Support

If you complete the pre-call checklist and determine that you need to contact PTC Technical Support, you can do so on the Web, by telephone, fax, or e-mail, as described in the following sections. In each case, Technical Support will issue you a unique call number in the format C######_#, for example, C1234567, that you can later use to track the resolution of your issue.
Opening Calls on the PTC Web Site

You can use the PTC Web site to open Technical Support calls 24 hours a day, 7 days a week, by using the Customer Care Call Logger tool located in the Technical Support section of the PTC Web site. This application provides easy-to-follow instructions and returns a call number immediately upon submission of all information. You can open a call on the Web in English, French, German, Italian, or Japanese.

Tracking Calls on the PTC Web Site

You can also use the PTC Web site to track your Technical Support calls by using Call Tracker located in the Technical Support page of the PTC Web site. You can view calls placed by your company to PTC Technical Support through this application. Call Tracker provides searching, tracking, and sorting capabilities. You can also add your own comments to a call. When comments are added, the technical support engineer assigned to your call is automatically notified. You can track a call on the PTC Web site in English, French, German, or Japanese.

Opening Calls by Telephone or Fax

To contact PTC Technical Support by telephone, see the list of phone numbers in the Worldwide Contact Information section at the back of this guide.

Opening Calls by E-Mail

Send e-mail to cs_ptc@ptc.com, with copen_format as the subject. PTC Technical Support will e-mail you a template and detailed information about how to open calls by e-mail. See the Technical Support page of the PTC Web site at www.ptc.com/cs/doc/copen.htm for the proper format for opening calls by e-mail. This page includes a template to download. In response to your message, your call will be routed according to your geographic location.

Processing Your Technical Support Calls

When you call PTC Technical Support at a number at the end of this guide, your call is routed to the appropriate automated call distribution (ACD) phone queue. Each queue corresponds to a specific PTC product or functionality. For details on call routing for Technical Support, see the diagrams under Telephone System Menu Maps Worldwide at www.ptc.com/cs/doc/cont_sup.htm.
If a technical support engineer is available, the system immediately routes your call to that engineer. If an engineer is not available within two to three minutes, the system gives you the following options:

- Continue to wait for the next available engineer
- Leave a voice mail message
- Speak directly with an operator

If you leave a message either on voice mail or with an operator, a technical support engineer will return your call within two business hours.

The Technical Support phone system is designed to provide you with flexible options and to let you speak directly with a technical support engineer as quickly as possible.

**Resolving Your Question**

A PTC technical support engineer will work with you to resolve your question to your satisfaction. Have the results of the pre-call checklist ready so that the engineer can provide you with efficient service. See Preparing for Your Call to Technical Support in this chapter for more information about the pre-call checklist. Be prepared to try to replicate the issue.

When Technical Support resolves your question, and you agree to the resolution, the status of the call is changed to “Resolved.” You can use a resolved call number for reference purposes. If you want to reopen a call that has been resolved, you can do so via the Web (by adding a comment) or by calling Technical Support.

**Note:** If you have a new technical issue to report, do not refer to a resolved call number. Instead, follow the steps for contacting Technical Support to open a new call. See Opening and Tracking a Call to Technical Support earlier in this chapter.

If the technical support engineer determines that more specific data is necessary to resolve your question, follow the appropriate procedure listed in *Sending the Data* in the next chapter. When Technical Support receives the additional information, they will contact you to confirm its receipt.

PTC Technical Support also provides you with the options of tracking software performance reports for issues reported by your company.
Software Performance Reports (SPR)

The technical support engineer analyzes your information and data. If the engineer detects a software issue, he or she submits an SPR. Technical Support uses SPRs to submit software issues to the PTC Software Development department for resolution. Each SPR has a unique number, for example, SPR123456, that you can use to identify the issue.

When an SPR is submitted, Technical Support assigns a severity to the SPR and notifies you of the SPR number issued for your call. Severities for SPRs are as follows:

- **EDown**—A production enterprise system is down.
- **Top Priority**—Highly critical software issue that is causing a work stoppage
- **High**—Critical software issue that affects immediate work
- **Medium**—Software issue that does not affect immediate work
- **Low**—Software issue that does not affect work

You can track the status of SPRs filed by your company using the Pro/SPR TRACKER Web application located in the Technical Support section of the PTC Web site. You can view SPRs filed by your company to PTC Technical Support with this application. The Pro/SPR TRACKER enables you to search, track, and sort your SPRs.

You can track an SPR on the PTC Web site in English, French, German, Italian, or Japanese.

When an SPR is resolved, the technical support engineer will notify you and send you a software correction or will refer you to the PTC Web site for downloadable fixes.

Escalation of Issues

PTC Technical Support provides customers with multiple mechanisms for escalating technical issues. You can increase the priority of a call or, if necessary, escalate a call to technical support management.

Increase the Priority of a Call

The priority of a call can be increased to reflect the current urgency of a particular issue. Technical Support uses this value to understand the impact of a particular issue for each customer. The priority of an existing call can be modified by either of the following methods:
• Web-based Call Tracker—The support engineer assigned to your call is notified automatically when the priority is modified in Call Tracker

• Technical Support toll-free phone numbers—Inform the technical support engineer of the new priority. Your call will be updated appropriately.

Escalate a Call to Technical Support Management

A call can be escalated to a Technical Support Manager if necessary. A manager will become directly involved in ensuring that the appropriate resources are working towards issue resolution. This may include the escalation of a Software Performance Report. A call can be escalated by one of the following methods:

• Web-based Call Tracker—The direct manager of the support engineer assigned to your call is notified automatically when the call is escalated in Call Tracker. Call Tracker allows you to escalate a call to the first escalation level. For any subsequent escalation request, you must contact Technical Support by one of the remaining escalation methods.

• Technical Support Feedback Line toll-free numbers

• Technical Support Feedback form at www.ptc.com/support/feedback/ts.htm

• Technical Support toll-free numbers

In each case, reference your Technical Support call number and you will be directed to the appropriate Technical Support Manager.

If calling the Feedback or Technical Support toll-free phone numbers, use the following procedure:

1. Upon entering the automated phone tree, select 0 (zero) to speak to a Technical Support Administrator.

2. Inform the Technical Support Administrator that you want to escalate a technical issue and provide the associated Technical Support call number. The Technical Support Administrator will transfer you to the appropriate manager.

3. If the manager is unavailable, the administrator will seek out a Technical Support Manager to address your escalation.
Understanding Call Priority

The priority of a call represents the importance or urgency of resolving the issue. A priority is assigned upon call initiation. This value can be updated at any point to reflect a change in the urgency of a resolution. The following outlines the definition of each priority and highlights the steps taken by the Technical Support engineer:

**Enterprise Down**—A production enterprise system is down.

- Technical Support management is notified when call is initiated or priority is increased.
- Technical Support works continuously with customer until resolution is reached or alternate technique is found.
- Development resources are contacted to assist with the troubleshooting process and, if necessary, provide a software update.
- Evaluation is completed to determine if 24-hour support is required.
- Formal management review is completed every 24 hours.
- If necessary, a Software Performance Report is filed to report a software defect.

**Extremely Critical**—A work stoppage that does not affect the entire enterprise has occurred.

- Issue is prioritized appropriately with the Technical Support contact.
- Technical Support works with customer to reach a resolution or alternate technique to eliminate the work stoppage as quickly as possible.
- Status updates are provided to customer on a regular basis.
- If necessary, a Software Performance Report is filed to report a software defect.

**Critical**—Work is severely impacted and a solution must be found quickly.

- Technical Support works with customer to reach a resolution or alternate technique as quickly as possible.
- Status updates are provided to customer on a regular basis.
• If necessary, a Software Performance Report is filed to report a software defect.

**Urgent**—Work is impacted but not significantly.

• Technical Support works with customer to reach a resolution or alternate technique.

• Technical Support works with customer to set appropriate status update timeframes.

• If necessary, a Software Performance Report is filed to report a software defect.

**Not Critical**—Work is slightly impacted but can easily be worked around.

• Technical Support works with customer to reach a resolution or alternate technique.

• If necessary, a Software Performance Report is filed to report a software defect.

### Understanding Escalation Levels

A call can be escalated to Technical Support Management if necessary (See Escalation of Issues for details on how to escalate a call). There are three levels of escalation within Technical Support.

**Escalation Level 1 (M1)**

• The call is escalated to the Technical Support Engineer’s direct supervisor.

• The Technical Support Manager will ensure that proper resources are applied to the call. By escalating a call, you are indicating that the call requires Technical Support management attention. A Technical Support Manager will ensure that you are contacted about the escalation.

**Escalation Level 2 (M2)**

• The call is escalated to a second level of Technical Support management.

• The Technical Support manager will work with the Technical Support Engineer and engineer’s supervisor to ensure that proper resources are applied to call.

• If necessary, a Software Performance Report will be escalated.
Escalation Level 3 (M3)

- The call is escalated to third-level of Technical Support management
- The Technical Support Manager will work with direct reports to ensure proper resources are applied.
- If necessary, a Software Performance Report will be further escalated.

Enhancements for Products

An enhancement is an idea or suggestion that PTC can evaluate for possible inclusion in future product releases. PTC appreciates your suggestions for software enhancements.

You may submit an enhancement to PTC or track the progress of a previously submitted enhancement using Web-based tools that are similar to, but different from, those used to contact PTC Technical Support.

Enhancements are automatically routed to the appropriate Product Management personnel for evaluation and consideration. PTC Technical Support does not handle or track enhancement requests.

In general, each new enhancement request is initially evaluated within approximately two or three weeks. As a result of this initial evaluation, an enhancement request may be categorized as:

- **Implemented**—This enhancement was implemented in release (number) of product (name).
- **Need More Info**—PTC needs the following additional information to consider this enhancement:
- **No Plans**—PTC does not plan to implement this enhancement at this time
- **Being Considered**—PTC will consider this enhancement for inclusion in future software releases.
- **Planned**—PTC is currently planning to include this enhancement in the next software release.

**Note:** Plans often change for a variety of reasons. Thus, although PTC may plan to include a specific enhancement in a specific software release, this is not a commitment to implement this enhancement in any release of any product. Only enhancements
with the category of “Implemented” are considered commitments by PTC.

After the initial evaluation of an enhancement request has been completed, all enhancements in the “Being Considered” category are evaluated for inclusion in each subsequent software release. However, since PTC generally provides software releases approximately once per year, the implementation of a specific enhancement can require an extended period of time.

If you want to emphasize the importance of a specific enhancement request, you should contact your sales representative.

**Submitting an Enhancement Request on the PTC Web Site**

You can use the PTC Web site to submit enhancement requests 24 hours a day, 7 days a week, by using the PTC Enhancement Request Logger located in the Technical Support section of the PTC Web site. This application provides easy-to-follow instructions and immediately returns an enhancement tracking number upon submission of all information. You can submit enhancements only in English at this time.

**Tracking Enhancement Requests on the PTC Web Site**

In English only at this time, you can also use the PTC Web site to track the progress of your enhancement request by using the PTC Enhancement Request Logger located in the Technical Support section of the PTC Web site. You can view enhancement requests placed by your company through this application. The PTC Enhancement Request Logger provides searching, tracking, and sorting capabilities. You can also add your own comments or any requested information to an enhancement request. When comments are added, the appropriate Product Manager is automatically notified.
Sometimes the technical support engineer requests additional data that can help PTC Technical Support replicate and solve your issue. This chapter describes the procedures to gather this data and send it to PTC Technical Support in the most efficient and effective way.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gathering the Required Data</td>
<td>6-2</td>
</tr>
<tr>
<td>Sending Multiple Files</td>
<td>6-8</td>
</tr>
<tr>
<td>Securing Data for Transfer</td>
<td>6-9</td>
</tr>
<tr>
<td>Sending the Data</td>
<td>6-11</td>
</tr>
</tbody>
</table>
Gathering the Required Data

The following sections explain how to gather the data you need to send to PTC Technical Support to successfully resolve your issues. Read the section or sections that refer to the software involved in your question. The sections are arranged alphabetically for your convenience.

**CADDs, Optegra, and DIMENSION III**
Collect the CADDs, Optegra, or DIMENSION III database files as directed by the technical support engineer handling your call.

**Electronic Design Entry (EDE)**
Gather all required data for Electronic Design Entry, including subfigures and rules files, into a single directory. Use the command `schfollow` to locate the subfigures used.

**Info*Engine**
Have the following information ready for assistance with Info*Engine products:
- Info*Engine task, template, and JSP files—Include the actual template file, not a just link to the template file.
- Server log file—Default location:
  `<Info*Engine loadpoint>\log\server.log`
- Adapter log file (`adapter.log`) — Include if running the adapter in a standalone configuration.
- Info*Engine properties file—Default location:
  `<Info*Engine loadpoint>\ie.properites`
- Enterprise access client and method source code (EBAI adapter only).

**DIVISION ProductView**
For DIVISION ProductView issues, have the following information ready to help solve your problem:
- `agent.ini` file from each folder under `<Graphics Server loadpoint>/ObjectAdapters`.
- Events folder contents in `<Graphics Server loadpoint>`.
worker.log file found on the CADWorker machine in the worker directory as referenced in the <Graphics Server loadpoint>/ObjectAdapters/cad/agent.ini file. The correct location for the worker.log file is shown in the host and exe entries in the agent.ini file.

- Repeatable steps required to duplicate the problem.

You can attach the files to an e-mail and send them using the procedure described in Sending the Data in this chapter.

**Pro/ENGINEER**

Follow these steps to save the latest copy of your Pro/ENGINEER database objects and create a trail file that captures your issue.

1. Create a new directory where you will save a copy of your Pro/ENGINEER objects. Give the directory a name that corresponds to your Technical Support call number, for example, C1234567.

2. Retrieve the Pro/ENGINEER part, assembly, or drawing with which you have an issue.

3. Click **File > Backup** and enter the name of the new directory you created in step 1. This creates a copy of the Pro/ENGINEER object or objects that Technical Support will use to answer your question. Always back up the highest level that the issue affects. For example, if the issue affects drawings, back up the drawing. This will automatically back up the model, part, or assembly as well.

4. Exit Pro/ENGINEER.

5. Change directory to the directory created in step 1.

6. If you want to save the trail file to a user-defined directory, use the **config.pro** option `trail_dir`.

7. Restart Pro/ENGINEER.

8. Create a new trail file by choosing the minimum number of menu options needed to recreate the issue.

9. Copy the most recent trail file that was just created (the `trail.txt` file with the greatest numerical suffix) to `C####.txt` in the directory created in step 1. (C#### is your Technical Support call number, for example, C1234567.)

10. Exit Pro/ENGINEER when you are finished.

11. To verify that the trail file contains your issue, run it as follows:
a. Start Pro/ENGINEER.

b. Click **Utilities > Play Trail/Training File.**

c. Enter the name of the trail file, for example, `C#######.txt`.

When you have finished preparing your data, see Sending the Data in this chapter.

---

**Pro/INTRALINK**

Follow these steps to create **TAR** or **ZIP** files of vault locations for Pro/INTRALINK files associated with your issue.

1. Log on to the Pro/INTRALINK data server as the user who installed the data server (usually user `oracle` on UNIX platforms or `administrator` on Windows platforms).

2. Create a data directory in which to store data for this issue. Usually the directory is named using the associated call number.

3. Ensure that all users are currently logged out of Pro/INTRALINK, but keep the data server running.

4. Create a dump file of the data server by running the script `ilink_export` as follows:

   For UNIX:
   ```
   <data server loadpoint>/intralink/export/ilink_export
   ```

   When prompted for the name of the dump file, include the path to the data directory created in step 2 so that the dump file will be created in the data directory.

   For Windows:
   ```
   <data server loadpoint>\intralink\export\ilink_export
   manager\<full_path_to_dir\dumpname.dmp>
   ```

5. Create a **TAR** or **ZIP** file of each Vault location and place those files in the data directory created in step 2.

When you have finished, see Sending the Data in this chapter.

---

**Pro/ENGINEER Simulation (formerly Mechanica)**

Follow these steps to prepare files for Pro/ENGINEER Structural and Thermal Simulation, which includes Mechanica, before sending them to PTC for consideration:
1. Create a new directory where you will save a copy of all necessary files associated with your question or issue.

2. Copy the following files and directories into this new directory, using all circumstances that apply:

   – If the problem occurs while you are working in integrated mode with Pro/ENGINEER, copy the Pro/ENGINEER part or assembly files, as well as the Simulation files, where applicable.

   – If the problem occurs during the model definition phase in independent mode and the original part or assembly is not associated with a Pro/ENGINEER model, copy only the Simulation database file.

   – If the problem occurs while you are running an analysis or design study, copy the entire subdirectory created for the analysis or design study, as well as the files identified in the two previous bulleted sections.

Following the previous steps automatically creates a trail file. When you have finished, see Sending the Data in this chapter.

**Routed Systems Designer**

To prepare a Routed Systems Designer file for PTC, use one of the following procedures to create a design or a package file:

To send the complete design as an `.rstd` file:

1. Create a new directory where you will save a copy of all necessary files associated with your question or issue.

2. Click **File > Open Design** to open the design.

3. Click **File > Pack Design** to create a design file.

4. Set the **Pack Directory** folder. The `.rstd` file of the design will be created in this folder.

5. Using Windows Explorer, create a folder with the call number (example C123456), and place this `.rstd` file into that folder.

6. Zip the entire folder to reduce the file size and avoid corruption during transfer.

To send the package file of the catalog or particular design sheets as a `.pkg` file:

1. Create a new directory where you will save a copy of all necessary files associated with your question or issue.
2. Click **File > Open Design** to open the design.

3. Click **File > Export > Package**. Using the Arrow button, move required items to the right side **Export Package Contents** box.

4. Click **Browse** and set the directory into which to export the package file.

5. Enter the name for the package file.

6. Click **OK**, and then click **Export**.

7. Using Windows Explorer, create a folder with the call number (example C123456), and place this .pkg file into that folder.

8. Zip the entire folder to reduce the file size and avoid corruption during transfer.

**Windchill Import and Export**

For issues regarding bulk loading, workflow import/export, lifecycle import/export, or sourcing import/export with Windchill, have the following information ready to help solve your problem:

- csvmapfile.txt file in <Windchill loadpoint>/loadfiles
- Any other .csv file related to the issue

The files must be packed in a TAR or ZIP file before they can be attached to an e-mail and sent using the procedure described in the section Sending the Data in this chapter.

**Windchill Information Modeler**

For Windchill Information Modeler issues, create an archive of the following files to help solve your problem:

- **Object model files**—Include the .mdl file and the corresponding .cat files. The object model files are normally found under the <Windchill loadpoint>/src directory.
- **Java source files**—Include source files created by the System Generator and any supporting Java source files you may have created (GUI and so forth.). These files are also normally found under the <Windchill loadpoint>/src directory.
- **SQL files**—Include any .sql files created by the system generator for your object model. These files are typically found in the <Windchill loadpoint>/db/sql directory.
To create this archive, use one of the following methods:

- **On Windows**—Create a ZIP file containing the files listed in the previous section. Be sure to include folder information relative to the top level of your Windchill load point.

  **Note:** The path within the ZIP file should not include the name of the Windchill installation directory. For example, files in the src directory should contain the path src/, not Windchill/src/.

- **On UNIX**—Create a TAR archive containing the files listed previously.

  **Note:** The files in the TAR archive must be specified without the name of the Windchill installation directory.

---

### Windchill Installation and Configuration

For Windchill installation and configuration issues, have the following information ready to help solve your problem:

- wt.properties file in `<Windchill loadpoint>/codebase`
- db.properties file in `<Windchill loadpoint>/db`
- MethodServer.log file in `<Windchill loadpoint>/logs`
- Environment variable listing—Generate a text file containing the current environment variable settings using the command for the appropriate platform:
  - Windows (in a Command Prompt window):
    
    ```
    set > environment.txt
    ```
  - UNIX (in a shell window):
    
    ```
    env > environment.txt
    ```
- Output from the Java console—Open the plug-in console window.
- Repeat the steps required to duplicate the problem.

You can attach the files to an e-mail and send them using the procedure described in Sending the Data in this chapter.

---

### Windchill Visualization

For Windchill Visualization issues, have the following information ready to help solve your problem:

- wvs.properties file in `<Windchill loadpoint>/codebase`
- wt.properties file in <Windchill loadpoint>/codebase
- agent.ini file in <Windchill loadpoint>/codebase
- cadagent folder contents in <Windchill loadpoint>/logs
- worker.log file found on the CADWorker machine in the worker directory as referenced in the agent.ini file. As listed in the agent.ini file, reference the host and .exe entries to find the correct location for the worker.log file.
- Repeatable steps required to duplicate the problem.

You can attach the files to an e-mail and send them using the procedure described in Sending the Data in this chapter.

Sending Multiple Files

After you complete the appropriate steps listed in the section Gathering the Required Data, follow the steps listed here to send multiple files to Technical Support.

On a UNIX Platform

Complete the steps outlined in the following table to send multiple files on a UNIX platform to Technical Support.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gather all required data into a single directory (called data_dir in the next two steps).</td>
<td>Follow the procedures outlined in Gathering the Required Data in this chapter.</td>
</tr>
<tr>
<td>2</td>
<td>Create a text file (here called README) in the directory that contains your call number and all pertinent information.</td>
<td>vi &lt;data_dir/README&gt;</td>
</tr>
<tr>
<td>3</td>
<td>Use the TAR command to create a single file.</td>
<td>tar cvf tar_file &lt;data_dir&gt;</td>
</tr>
<tr>
<td>4</td>
<td>Compress the TAR file.</td>
<td>Compress tar_file</td>
</tr>
<tr>
<td>5</td>
<td>Encode the compressed file, using your call number as the output file name.</td>
<td>Encode tar_file.Z tar_file.Z &gt; C#### (one command, one line)</td>
</tr>
</tbody>
</table>
### Sending Additional Data to Technical Support 6-9

**Step** | **Action** | **Method**
--- | --- | ---
6 | Send the file to PTC. | Send by e-mail, FTP, or tape, using the appropriate technique. See Sending the Data in this chapter.

### On a Windows Platform

Complete the steps outlined in the following table to send multiple files on a Windows platform to Technical Support.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Copy required data to a single directory.</td>
<td><code>copy &lt;files&gt; data_dir</code> or use the File Manager.</td>
</tr>
<tr>
<td>2</td>
<td>In the directory you made in step 1, create a file named README that has the call number and all pertinent information.</td>
<td><code>notepad data_dir/README</code></td>
</tr>
</tbody>
</table>
| 3 | Use the PKZIP command or WinZip to create a single file. | `PKZIP zip_file ptc_dir`  
WinZip |
| 4 | Send the file to PTC. | Send by e-mail, FTP, floppy disk, Zip disk, CD, or tape in a format available both at your site and at PTC, using the appropriate technique. See Sending the Data in this chapter. |

### Securing Data for Transfer

PTC is pleased to provide a secure way to transfer data to Technical Support. PGP has been chosen as the encryption tool because of its high level of security and support for a wide variety of platforms. (For more details on PGP, see [www.ptc.com/cs/doc/pgp.htm](http://www.ptc.com/cs/doc/pgp.htm).) The handling of Non-Disclosure Agreements (NDA) and International Traffic in Arms Regulations (ITAR) is described in this section.

### Handling NDA Data

Sometimes you may have confidential or proprietary data necessary to investigate and resolve a technical problem. To send such proprietary data to PTC, follow these steps:
1. Tell the technical support engineer that you will be providing proprietary data that should be covered by a Non-Disclosure Agreement (NDA).

   The technical support engineer will send you a Confidential Information Transmittal Record (CITR) form to fill out. If no NDA is in effect, you will receive a standard NDA to execute and send to PTC prior to sending the CITR and the data.

2. Use the CITR form to list the specific data files that are covered by the NDA. This is required.

   PTC will also sign the completed form, as a commitment to safeguard your data according to the requirements of the NDA.

3. Transfer the NDA data to PTC using one of the methods described in the Sending the Data section. Agree upon the transfer method with the assigned technical support engineer and in accordance with your company’s data transfer policies

When the issue is resolved, PTC deletes the NDA data from any systems where it was stored and destroys or returns any media (such as CDs or tapes) containing the data at your option. (Backup tapes for systems archival or maintenance purposes may be maintained).

**Handling ITAR Data**

Many companies in defense-related businesses must follow the U.S. International Traffic in Arms Regulations (ITAR). If you need to send data to PTC that is covered by ITAR, follow these steps:

1. Inform the technical support engineer that you will be providing ITAR data.

   PTC will then ensure that the technical support engineer assigned to handle your data (and anyone else at PTC who will handle your data) is a U.S. citizen or permanent resident. PTC will assign your call to another engineer, if necessary, to satisfy this requirement. PTC will also ensure that your data will not be exported outside the United States.

   The assigned technical support engineer will then send you an Export Controlled Data Transmittal (ECDT) form to fill out.

2. Use this form to list the specific data files that are covered by ITAR. This step is required.

   PTC will also sign the completed form, as a commitment to safeguard your data according to the ITAR requirements.
3. Transfer the ITAR data to PTC using one of the methods described in the Sending the Data section. Agree upon the transfer method with the assigned technical support engineer and in accordance with your company's data transfer policies.

When the issue is resolved, PTC deletes the ITAR data from any systems where it was stored and destroys or returns any media (such as CDs or tapes) containing the data at your option. (System backup tapes used for systems archival or maintenance purposes may be maintained).

Sending the Data

If you are sending multiple files, remember to create a single directory and send that one directory. See Sending Multiple Files in this chapter for more information. The previous section explains the handling of NDA and ITAR data.

Sending the Data on Floppy Disk, Zip Disk, CD, or Tape Media

To send data on a floppy disk, Zip disk, CD, or tape media, use the following procedure:

1. Complete the steps in Gathering the Required Data and copy the requested information to the media. If tape media is used, ensure that the tape format is available both at the your site and at PTC.

2. Obtain a PTC call-tracking number for your issue (see Opening and Tracking a Call to Technical Support in the previous chapter). Write the call-tracking number on the media label.

3. Mail the media to the support center in your region.

   **Note:** Media (disks, CDs, and tapes) will not be returned. Keep a copy of the data for your own reference.

Sending the Data Using the PTC File Transfer Protocol (FTP) Server

The PTC FTP server includes a Technical Support area, which you can use to transfer files. This area is configured with write-only privileges. Connect to the PTC FTP server using an FTP client program in one of the following ways:

- From the FTP site
- From the graphical user interface
- From your Web browser
Requirements for Data You Send to the PTC FTP Site

Whenever you use FTP to send data to the PTC Technical Support area, make sure that your data meets the following requirements:

- The file name must be an open, valid Technical Support call number. For example, the file name must be in the form C########.*, where C######## is an open Technical Support call number and the asterisk (*) indicates any file extension, such as .tar, .Z, or .zip.

Data must be in a single-file format. If you want to send multiple files, you must incorporate them into single-file format. See Sending Multiple Files in this chapter for more information.

Connecting to the PTC FTP Server

The PTC FTP server is located at ftp://ftp.ptc.com. To access this server, use the following user name and password:

- Username: cs
- Password: cs

From Command Line

If you are accessing the PTC FTP server from a command-line program:

1. Type ftp.ptc.com at a command-line prompt.
2. When the username is requested, type cs.
3. When the password is requested, type cs.
4. Make sure you are sending the information using binary as the transfer type. At the FTP prompt, type binary.
5. Use the put command to upload the file at the FTP prompt. For example, to upload C1234567.Z, type put C1234567.Z.
6. Exit from FTP by typing bye.

From FTP Client with Graphical User Interface

If you are using an FTP client program with a graphical user interface, connect to ftp://ftp.ptc.com with a user name of cs and a password of cs. Make sure that this program will transfer the file using binary as the transfer type before sending the file.
From Web Browser

If you are accessing the PTC FTP server from your Web browser, use the following address: ftp://cs:cs@ftp.ptc.com

After the page finishes loading, you are ready to upload your file or files.

- Netscape 4.x and later:
  - Select **File > Upload File.**
  - Select your file and select **Open.**

- Microsoft Internet Explorer 4.x and later:
  - Drag the files from Windows Explorer into Internet Explorer.

**Note:** Internet Explorer does not display the FTP server banner messages.

Sending Data by E-Mail

To send your data related to an existing open PTC call to Technical Support via e-mail, complete the following steps:

**Note:** If you do not have a call number, you can obtain one by contacting PTC Technical Support. See Preparing for Your Call to Technical Support in the previous chapter for more information on preparing for your call to Technical Support.

1. Compose your e-mail message. Include the following information:
   - Description of your issue
   - Priority level
   - Person at your site whom PTC should contact to request more information or to communicate a resolution
   - List the files you are including in the e-mail and document the steps you followed to prepare data for sending.

2. If you are sending multiple files or PTC database objects such as parts, drawings, design studies, and so forth, gather the required data and create a single file by using the procedure outlined in the section Gathering the Required Data in this chapter. Include the file in the message as an attachment.

3. Send the e-mail to cs_ptc@ptc.com and specify your call number as the subject of the e-mail message with the single data file attached.

When the data is received, the technical support engineer assigned to your call is notified automatically.
Whenever you send data to PTC by e-mail, make sure you satisfy the following requirements:

- PTC Technical Support can accept e-mail only if the call number is currently open in the Technical Support call database. The call number must be in the form C######, for example, C1234567.

- The size of the e-mail file you send must not exceed 4 MB. If it exceeds 4 MB, PTC will return it to you.

Be aware that some route-through Internet modes might place additional limitations on the amount of data you can pass through them.

**Sending Data Using Call Logger and Call Tracker**

Complete the following steps to use Call Logger and Call Tracker to upload a file for Technical Support to review.

1. Enter a description for the issue related to the file you want to upload. (255 characters maximum)

2. Click **Launch File Upload Tool** or **Begin Upload** to select the file. Limit the file size to a maximum of 7 MB.

**Note:** When the data is received, the technical support engineer assigned to your call is notified automatically.
PTC Technical Support provides guidelines for customizing and implementing Windchill Solutions. This chapter describes the requirements your Windchill Solution customization must meet to be supported.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>7-2</td>
</tr>
<tr>
<td>Supported Configurations</td>
<td>7-4</td>
</tr>
<tr>
<td>Supported Windchill Solution Releases</td>
<td>7-5</td>
</tr>
<tr>
<td>Supported and Nonsupported Usage of the API</td>
<td>7-7</td>
</tr>
<tr>
<td>Support of Third-Party Products</td>
<td>7-9</td>
</tr>
<tr>
<td>Support for PTC PLM On Demand</td>
<td>7-13</td>
</tr>
<tr>
<td>Windchill Maintenance and Patches</td>
<td>7-15</td>
</tr>
</tbody>
</table>
Overview

Windchill Solutions offers a highly collaborative, fully customized environment in which to get your product to market faster and more efficiently. Because customization is a key element of Windchill Solutions, you need guidelines on how to design and implement your customization more effectively.

Another important aspect of Windchill Solutions is their interoperability with several third-party products. PTC Technical Support supports the use of these products to a limited extent when providing support for Windchill Solutions.

License Agreement and Legal Obligations

PTC contractual support obligations, if any, are solely as set forth in the applicable license agreement between PTC and its customer.

PTC Technical Support provides only discretionary support for customized implementations of Windchill Solutions. Although the guidelines in this chapter set forth current practices, nothing in these guidelines shall be construed or deemed to impose any contractual or other legal obligation on PTC.

Customization

You can customize your deployment of a Windchill Solution to best suit your needs. You can create an infinite number of customizations for Windchill Solutions, but Technical Support cannot support each unique customization. By following the guidelines in this chapter, you can help ensure that PTC Technical Support can support your customization.

Using the Customization Toolkit

Windchill Solutions are shipped with a large customization toolkit. This toolkit consists of a Java Application Programming Interface (API) and associated tools, which include the following items:

- Java source files
- JavaDoc documentation
- Rational Rose object models

Not all customizations, even if technically possible using these resources, can be supported. Other Windchill Solutions offer lighter customization capabilities. Many of the customization guidelines described in this chapter also apply to lightweight customization.
Requirements for Customization

Individuals or groups customizing Windchill Solutions receive support only if they follow the guidelines described in this chapter. In particular, customizations employing the following practices are not supported, and Technical Support reserves the right to deny assistance under the following circumstances:

- Use of unsupported APIs
- Use of modified out-of-the-box classes or new classes that result from decompiling code
- Renaming of classes
- Modification of classes
- Recompilation of classes

Interaction with Third-Party Products

Installing and administering a Windchill Solution involves interacting with several third-party products, such as databases, Web servers, search engines, and so forth. Technical Support provides limited assistance in configuring third-party products to interact properly with a Windchill Solution, but it does not support them.

Support of End Users

Support for production systems is given only to the designated contacts who are listed in the support contract with PTC (See the PTC Customer Agreement for License Products.). These contacts must technically understand the customization thoroughly enough to work with Technical Support to ensure successful and timely resolution of customization issues.

PTC will not provide support to end users for any system in production. Therefore, end users of Windchill Solution customizations must contact their local Windchill Solution Administrator. The Windchill Solution Administrator can then contact Technical Support for assistance in resolving any issues related to the core Windchill Solution software.

Each designated contact is responsible for dealing with end-user issues, as well as with software errors. If you suspect that an issue or software error is related not to the customization but to the Windchill Solution product itself, you can contact Technical Support. Whenever contacting Technical Support, you must be able to clearly demonstrate why the issue is related only to your Windchill Solution, and not to the customization. You must be able to demonstrate the issue using an out-
of-the-box Windchill Solution installation whenever possible. If this is not feasible, Technical Support may deploy your customization within PTC to confirm that the issue is Windchill Solution related. If it is, Technical Support takes the appropriate action, such as providing assistance in finding a workaround, filing a software performance report (SPR), and so forth.

Error Tracking

PTC Technical Support can track those software errors found in the core Windchill Solution software. If you choose to customize a Windchill Solution independently, then you are responsible for the maintenance support of that customization. However, Technical Support is available if assistance is required on a specific customization topic, or if an error is identified in the core product and must be submitted to PTC Research and Development.

Supported Configurations

The Windchill Solution product suite interacts with many operating systems and third-party products. A partial listing includes

- The hardware on which Windchill Solution is running (brand, operating system level, Service Pack level for Windows)
- The release of Oracle
- The release of the Java Development Kit (JDK)/Java Runtime Environment (JRE)
- The release of the Web server—Internet Information Server (IIS) or Netscape Enterprise Server (NES)

PTC Quality Assurance tests and validates a given release of a Windchill Solution on many combinations of the above parameters. A list of supported configurations is available in the release notes and under Interoperability Matrices and Compatibility Matrices on the PTC Web site at [www.ptc.com/cgi/cs/doc/document.pl?product=WNC](http://www.ptc.com/cgi/cs/doc/document.pl?product=WNC). If you run a Windchill Solution on a supported configuration, you ensure that Technical Support has the same access to the supported hardware and software environments that you do. Technical Support uses the hardware and software environments to analyze and reproduce your issue. Any errors found on such a configuration are reported to Development through a software performance report (SPR) for correction in a later downloadable software update (DSU) or release.

Technical Support is only provided for configurations listed in the installation guides, Read This Firsts, and the matrices found on the
PTC Web site. Therefore, to ensure satisfactory support of deployed systems, refer to these product matrices before implementing your Windchill Solution or upgrading any of its components. Please contact Technical Support with any questions about supported configurations.

For third-party products inclusive of common platform applications: Technical Support analyzes and works to resolve any third-party issues that are related to a Windchill Solution. However, any non-Windchill Solution-related issues concerning third-party products will not be addressed. In general, Technical Support provides you with the information on what change has to be made to the third-party product in order for it to operate with a Windchill Solution. The implementation of this recommended change is not the responsibility of Technical Support. For example, Technical Support can assist in creating the Oracle database schema for a Windchill Solution. It does not support the use of additional Oracle tools. Recommendations to optimize performance of third party products are not supplied.

Recommendations to optimize configurations for Windchill server performance, including property files, and recommendations for configuration of backup and recovery strategies are available from PTC Global Services and are not part of PTC Maintenance Services. Technical Support is only provided for configurations officially supported by PTC.

**Supported Windchill Solution Releases**

PTC Development supports a given release of a Windchill Solution for a limited period of time. After the support period has lapsed, any errors reported against the release are corrected only in a later release. Updated information for new releases is available from Technical Support at [www.ptc.com/cs/doc/pds_calendar.pdf](http://www.ptc.com/cs/doc/pds_calendar.pdf).

**Multiple Windchill Instances**

In most cases, you can run two concurrent instances of the same Windchill Solution on the same server. PTC can support Windchill Solution functionality in such an environment under the conditions described in this section.

The installation, configuration, or troubleshooting of the actual setup of a multi-Windchill instance server is the responsibility of the customer. PTC does not test and document all possible third-party product configurations running simultaneously on same server with multiple Windchill instances. It is the responsibility of each third-party vendor to determine whether it is possible or supportable to run multiple instances of their application on the same server.
PTC Technical Support assists with Windchill Solution issues (such as administration, workflow, and so on) unrelated to this multiple Windchill, single-server configuration as long as each Windchill instance is configured with its own Web server and its own servlet engine. In such cases, PTC Technical Support may require one of the Windchill Solution instances (along with its Web server and servlet engine) be shut down to isolate the problem to only one Windchill Solution instance. If shutting down one of the Windchill Solution instances (along with its related Web server and servlet engine) eliminates the problem, then PTC Technical Support will not proceed in troubleshooting the issue. In such a case, it may be a third-party product configuration that is at fault, and PTC would be unable to identify all potential causes to such problems. You must isolate the problem to the specific third-party product and work with that vendor to find a solution.

Note:

- Runtime performance issues in a production, test, or development environment related to this configuration are not supported.
- Some third-party vendors may not support the configuration of multiple instances of their software on a single server. In such cases, PTC cannot provide any support for a system configured in this fashion.

**Support of Dataloader Tools**

Some Windchill Solutions provide a default dataloader for use with the demo, which is included on the Windchill Solution CD. Technical Support is provided for this tool.

As a Windchill Solution Administrator, you have dataloading needs for which you modify this default dataloader, or in some cases, create your own. As with any other customization, support is provided only for Windchill Solution APIs.

- Support is not provided for the following dataloader problems:
  - Dataloader code problems unrelated to Windchill Solution APIs
  - Dataloaders that do not use Windchill Solution APIs

**Support of Windchill Customization**

You should have significant experience with Java programming before working with Windchill Customization or developing workflow tasks in Java. Therefore, support for the following four areas is at the discretion of PTC Technical Support.
**Support for Java Programming**

PTC Technical Support for Java programming is limited only to advice. For example, Technical Support engineers will not develop code for customers, nor will they assist them in debugging or troubleshooting pure Java code.

**Information Modeler**

You can use Information Modeler (IM) to customize Windchill Solutions for the following tasks:

- Modeling business objects and services
- Implementing business objects and services
- Designing user interfaces

Create business objects to represent domain entities for a specific customer or application. Use services to add or change server-side business logic within the system. Both types of customization are located on the business layer (middle tier) of Windchill Solutions. Therefore, you must model your customization within Rational Rose. Technical Support provides basic assistance for these tasks.

**Programming Styles**

Adhere to the guidelines that are given in the *Windchill Customizer's Guide* and *Windchill Application Developer's Guide* when customizing Windchill Solutions. The customization framework and design patterns described in these documents ensure supportability and compatibility with future releases of Windchill Solutions. However, Technical Support reserves the right to deny support in cases where rules of reasonable development are violated.

**Customer Source Code Examples**

In some cases, you will have to submit code to Technical Support. Rather than sending the whole customization, send in an example that demonstrates the specific Information Modeler issue. Technical Support will not troubleshoot or debug large code examples (hundreds of lines).

**Supported and Nonsupported Usage of the API**

The requirements mentioned in the previous sections are subject to the judgment of Technical Support and the urgency of the issue. In
addition, you must adhere strictly to the requirements that follow to receive support for Information Modeler.

**Decompiling Source Code**

You can reverse-engineer Java class files into source code using tools that are widely available. Decompiling source code is legally prohibited. PTC will not support class files created by making changes to decompiled source code and replacing existing class files.

**Supported Languages**

You must use one or more of the following languages to ensure that Technical Support can support your customization:

- Java
- HTML (including Windchill HTML templates) or JSP
- XML
- JavaScript (see JavaScript in this chapter for more information)

In many cases, other languages are required to implement a specific function in the customization. Although using this technology is valid, Technical Support limits its support to the usage of the delivered Windchill development materials. It is your responsibility to enable Technical Support to reproduce your issue without having to install, or have specialized knowledge of, these technologies. Some examples of nonsupported customizations include:

- Using Java’s JNI to integrate C code
- Launching a Perl interpreter
- Using active server pages to interact with Windchill

**Modification of Existing Windchill Classes**

You can modify existing Windchill classes if the corresponding source code is provided with the Windchill Customization installation. In most cases modifications only apply to resource bundles. In the case of large source files available to customers, as an Information Modeler (IM) developer, you should take care that only small, reasonable changes are made. You must fully understand the logic of the source code before manipulating it. If you make changes that are inconsistent with the original code, support is provided only on a limited basis. Also, you should indicate any changes clearly in the source file using comments.
For example, you might want to add or delete menus for the WTExplorerFrame class. This action can be done easily and is a valid customization. However, if the underlying logic of the Document Explorer client has been changed completely, such as through the rewriting of large portions of the source code, Technical Support may be unable to provide support.

**Windchill Classes**

Although technically every class file in the Windchill codebase can be used in customization source code, usage of Windchill classes is subject to restrictions. Using a class includes accessing any field or method of that class, or creating instances of the class.

To use a class, the class must be described in the JavaDoc. The JavaDoc of every class contains a Supported API field. This entry must be set to `true` in order for the class to be supported for use within customizations. If a field or method of a class is used, the entry Supported API for this field or method must not be set to `false`. If there is no Supported API entry field or method, but the class itself is a supported API, then the field or method is considered as supported also.

**Windchill Class Extensions**

Extending a class is a special case of using a class. In addition, to make supported class extensions, the parent class must be indicated as extendable in the JavaDoc by the field `Extendable: true`. All requirements described in Using Windchill Classes apply to extending classes.

**JavaScript**

You can use JavaScript to provide better usability for HTML user interfaces. Technical Support does not address complex queries. However, it does investigate conflicts between JavaScript and Windchill if an error due to Windchill is suspected.

**Support of Third-Party Products**

Installing and administering a Windchill Solution involves interacting with several third-party products, such as the Convera RetrievalWare search engine, Oracle database, Rational Rose, Web servers, and Web browsers Rational Rose. PTC Technical Support provides varying levels of assistance for issues related to third-party products.
Installation

Installation of third-party products is supported. The third-party product must operate properly before any issues concerning this product are reported to Technical Support. For example, troubleshooting the installation of other infrastructures such as mail servers, Web servers, and LDAP databases is not provided. Please see the section Supported and Non-supported Third-Party Issues in this chapter for issues involving specific third-party products.

Configuration

Technical Support analyzes and works to resolve any third-party issue that is related to a Windchill Solution. However, any issue not related to a Windchill Solution will not be addressed.

In general, Technical Support recommends what change has to be made to the third-party product for it to operate with a Windchill Solution. The implementation of this change is not the responsibility of Technical Support. In some cases, however, assistance is provided on a time-available basis. For example, Technical Support can assist in creating the Oracle database schema for a Windchill Solution. It does not support the use of additional Oracle tools.

Software Errors

Report errors in third-party products related to a Windchill Solution to Technical Support. A Software Performance Report (SPR) is opened to report the issue to Windchill Development and Technical Marketing. For issues with the products bundled with a Windchill Solution, the error is reported to the corresponding third-party company. At that point, PTC decides how to address the issue. The result can range from a third-party fix, a correction in Windchill Solution software to accommodate the error, or a substitute product.

Supported and Non-supported Third-Party Issues

The next tables provide a brief overview of third-party products and issues supported by Technical Support. This list includes a sampling (for the purpose of example) of supported and non-supported tasks.
### IDE (Integrated Development Environment)

<table>
<thead>
<tr>
<th>Issues Supported</th>
<th>Issues Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a Windchill JavaBean</td>
<td>Creating user interfaces using non-Windchill GUI components, such as AWT and Swing</td>
</tr>
<tr>
<td>Including the Windchill codebase in input/output path</td>
<td>Assisting in the debugging of code</td>
</tr>
</tbody>
</table>

### Convera RetrievalWare Search Engine

<table>
<thead>
<tr>
<th>Issues Supported</th>
<th>Issues Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Windchill Solution collections for indexing a single or multiple Windchill Solution servers</td>
<td>Adding and maintaining collections for objects outside of a Windchill Solution</td>
</tr>
<tr>
<td>Bulk loading indexes</td>
<td>Filtering and tuning an index</td>
</tr>
<tr>
<td>Applying indexing rules to domains</td>
<td>Using Convera RetrievalWare-specific query, scripting languages, or template customization</td>
</tr>
</tbody>
</table>

### Oracle Database

<table>
<thead>
<tr>
<th>Issues Supported</th>
<th>Issues Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating the database schema for a Windchill Solution</td>
<td>Creating an Oracle instance</td>
</tr>
<tr>
<td>Making changes to an Oracle instance necessary for a Windchill Solution, such as creating the blobs tablespace</td>
<td>Tuning general Oracle performance based on observing a running system</td>
</tr>
<tr>
<td>Recommending specific Oracle settings to improve Windchill Solution performance, such as which tables or attributes are good candidates for indexes</td>
<td>Repairing corruption of the Oracle instance, such as defective Oracle blocks</td>
</tr>
</tbody>
</table>

**Note:** For more specific Oracle performance recommendations, contact PTC Global Services Organization.
## Issues Supported

<table>
<thead>
<tr>
<th>Issue Supported</th>
<th>Issue Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repairing corruption of the Windchill Solution database schema</td>
<td>Restoring an Oracle backup</td>
</tr>
<tr>
<td></td>
<td>Recovering the database</td>
</tr>
</tbody>
</table>

## Rational Rose

<table>
<thead>
<tr>
<th>Issue Supported</th>
<th>Issue Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Rational Rose Windchill extensions properly (Windchill tabs)</td>
<td>Explaining UML or how to create general UML models with Rational Rose</td>
</tr>
<tr>
<td>Generating code</td>
<td></td>
</tr>
<tr>
<td>Packaging UML models properly, such as organizing <code>.mdl</code> and <code>.cat</code> files.</td>
<td></td>
</tr>
</tbody>
</table>

## Web Server

<table>
<thead>
<tr>
<th>Issue Supported</th>
<th>Issue Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating necessary aliases for a Windchill Solution</td>
<td>Configuring or compiling non-Windchill webserver modules (that is, mod_perl)</td>
</tr>
<tr>
<td>Applying access controls for authentication</td>
<td></td>
</tr>
</tbody>
</table>

## Web Browsers

<table>
<thead>
<tr>
<th>Issue Supported</th>
<th>Issue Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Providing basic setup assistance for interaction with a Windchill Solution, such as enabling Java or JavaScript</td>
<td>Using general browser settings</td>
</tr>
<tr>
<td>Enabling bootstrapping for faster loading of Java classes</td>
<td>Applying vendor recommended patches</td>
</tr>
</tbody>
</table>

## Support Contracts with Third-Party Vendors

Support contracts vary with each third-party vendor. When planning your customization, set up support contracts as necessary.
• **Apache and Tomcat**—The Apache Web server and Tomcat servlet engine ship with the Windchill Solutions. These third-party products are a free and out-of-the-box Web server and servlet engine solution. To ensure the quality of these solutions, PTC tests each Windchill release with the supported versions of these products. As a further level of support for Apache, PTC strives to release updated, recompiled Apache binaries to address significant security patches reported by the Apache user community.

As PTC is not the licensor of these products, the responsibility of PTC Technical Support is limited to the interaction between Windchill and the versions of these products shipped with Windchill. If you want to customize and recompile Apache or available modules yourself and need assistance, you would get support from the Apache user community, not PTC Technical Support.

• **Convera RetrievalWare and Rational Rose**—PTC is the official licensor of Convera RetrievalWare and Rational Rose. Therefore, you must go through PTC for support issues. PTC Technical Support is responsible for issues involving these products and for contacting the vendors’ technical support organization when necessary.

• **Info*Engine**—You must establish a support contract with vendors of legacy databases that are accessed using Info*Engine.

• **Oracle**—You must establish a support contract with Oracle. Oracle database is one of the main components of a Windchill Solution and is critical for maintaining the integrity of data.

• **ProductView**—You can configure ProductView to visualize the geometry and product structure of CAD models from many vendors. These models can be accessed from the file system directly or from other PDM systems available on the market. You should establish a support contract with the vendors of those CAD or PDM systems, such as CATIA and I-DEAS.

• **Windchill MCAD and ECAD Integrations**—You can configure Windchill to integrate with third-party CAD systems from many vendors. You should establish a support contracts with the vendors of those third-party CAD systems, such as CATIA and I-DEAS.

**Support for PTC PLM On Demand**

If you want the benefits of Product Lifecycle Management (PLM), PTC PLM On Demand is a subscription service for Windchill PDMLink and Windchill ProjectLink that offers electronic access to Technical
Support. Each customer site has one Super User who can contact PTC Technical Support during business hours. All other users go through their designated Super User for support.

Using PLM On Demand as a Super User

To access PLM support, the Super User uses the H = type SCN. This SCN has the following format: #H#######, for example, 5H1234567. The interface points the Super User to Call Logger and all other users to the designated Super User.

All communication with PTC Technical Support is done electronically for this service. In each case, Technical Support immediately issues a unique support request number in the format C########, for example, C1234567. Use this number to track the status of your issue.

Your can access the PTC On Demand Super User Support area in following ways:

- On your browser, select Support > PTC PLM On Demand and click Super User Support.
- On the PTC Website, select Customer Resources > PTC PLM On Demand and click Super User Support.

The Super User can also use Call Logger via the Technical Support page of the PTC Web site. File your request for a product of Windchill PDMLink (Home, Products, Change, and Library tabs) or Windchill ProjectLink (Project tab) with PLM On Demand.

Call Logger provides easy-to-follow instructions and returns a service request number immediately upon submission of all information. You will receive an electronic response back in four business hours or fewer.

Following Up a Logged Call for PLM On Demand

To follow up a logged call, send the e-mail to cs_ptc@ptc.com and specify your call number, for example, C1234567, as the subject of the e-mail. To track the status of a call or contact a technical support engineer, add a comment using Call Tracker on the PTC Web site.

For further information on tracking your requests for support, their resolution, priorities, and the escalation of issues, read the previous applicable sections.
Windchill Maintenance and Patches

The application of code corrections is part of the normal maintenance of your Windchill system. PTC provides maintenance for Windchill products and applicable third-party applications via the following release vehicles:

- Maintenance releases
- Temporary patches

Quarterly maintenance releases provide code corrections for critical issues. They contain fixes for SPRs (Software Performance Reports) that have been reported to PTC. You can order these updates in CD-ROM, or you can download them from www.ptc.com/support/support.htm, the PTC Support Web site.

Temporary patches are emergency, single-issue code corrections for specific customers. Any code delivered in temporary patches is automatically added to the next available maintenance release. After the code has been incorporated into a maintenance release, the temporary patch should not be installed. Technical support for the temporary patch ceases when the maintenance release containing the permanent fix is released.
The PTC Web site is a powerful tool for accessing information about PTC and its products, as well as for interacting with Technical Support and the Customer Care Center. This chapter provides information on using the PTC Web site.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inside the PTC Technical Support Web Site</td>
<td>8-2</td>
</tr>
<tr>
<td>24-Hour Access to Calls, SPRs, and TANs</td>
<td>8-4</td>
</tr>
<tr>
<td>Connecting to the PTC Technical Support Web Site</td>
<td>8-5</td>
</tr>
<tr>
<td>PTC Online Accounts</td>
<td>8-5</td>
</tr>
</tbody>
</table>
Inside the PTC Technical Support Web Site

PTC Technical Support maintains an extensive database of practical tips and techniques from years of customer contact. Through the Web site at www.ptc.com/support/support.htm, you can read more than 18,000 documents, updated weekly, that contain the latest technical information. The site is organized by functional area. You can use the PTC Web site 24 hours a day, 7 days a week, to take advantage of many benefits, such as the following:

- PTC software design techniques
- Effective use of PTC products through step-by-step design methods
- Product knowledge enhancement
- Productivity-boosting solutions to common design challenges
- In-depth answers to Frequently Asked Questions (FAQs)
- Call opening and tracking
- SPR tracking
- Technical Application Notes (TANs)

The Technical Support Web site contains a Knowledge Base, Web tools for customers, and user documentation. The next three tables list the resources and describe how the information can help you.

### Knowledge Base

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggested Techniques</td>
<td>Provides step-by-step instructions, including color graphics, on how to use PTC software to complete common tasks.</td>
</tr>
<tr>
<td>Frequently Asked Questions (FAQs)</td>
<td>Provides answers to many of the most commonly asked questions from the PTC Technical Support database.</td>
</tr>
<tr>
<td>Technical Application Notes (TANs)</td>
<td>Provides information on the functionality of PTC software solutions and timely information on alternative techniques and solutions to common software issues.</td>
</tr>
<tr>
<td>Type of Information</td>
<td>Purpose</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Technical Point of Interest (TPIs)</td>
<td>Provides technical tips that are not necessarily associated with a particular release of a PTC software product.</td>
</tr>
<tr>
<td>Hardware Configuration Notes</td>
<td>Provides the most up-to-date hardware configuration requirements for all PTC-supported platforms, including workstation models, operating systems, graphics configurations, and required operating system patches, as well as access to hardware vendor FAQs and Web sites.</td>
</tr>
</tbody>
</table>

**Web Tools**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Logger</td>
<td>Provides easy-to-follow instructions for opening customer support calls on the Web. Returns a call number upon submission of the call information.</td>
</tr>
<tr>
<td>Call Tracker</td>
<td>Allows you to view your calls online and Provides online searching, tracking, and sorting capabilities for your calls and to add comments to your call. It automatically notifies the technical support engineer assigned to the call when comments are added.</td>
</tr>
<tr>
<td>Pro/SPR TRACKER</td>
<td>Enables you to track the status of your SPRs online.</td>
</tr>
<tr>
<td>Update Advisor</td>
<td>Provides information to help to determine the value in updating to a release or datecode</td>
</tr>
<tr>
<td>Knowledge Base Monitor</td>
<td>Allows you to subscribe to multiple product and module combinations. When the application detects a match between a TAN or TPI and your predefined criteria, PTC will send you notification by e-mail with a link to the new or modified technical document. You can...</td>
</tr>
<tr>
<td>Tool</td>
<td>Purpose</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>redefine your subscription criteria at anytime.</td>
</tr>
<tr>
<td></td>
<td>Allows you to request shipment or download of a software update for any</td>
</tr>
<tr>
<td></td>
<td>PTC software product.</td>
</tr>
</tbody>
</table>

**Reference Documentation**

<table>
<thead>
<tr>
<th>Document</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide</td>
<td>Provides detailed instructions on how to install any specific PTC software</td>
</tr>
<tr>
<td></td>
<td>package.</td>
</tr>
<tr>
<td>Release Notes or What’s New</td>
<td>Provides information on a particular release of a particular product.</td>
</tr>
<tr>
<td>Read This First</td>
<td>Provides a summary of the important information about installation,</td>
</tr>
<tr>
<td></td>
<td>platform requirements, operational issues, and other topics that you</td>
</tr>
<tr>
<td></td>
<td>should read before installing and running the release.</td>
</tr>
<tr>
<td>Quick Reference Cards</td>
<td>Provides graphical quick-reference diagrams that summarize the user</td>
</tr>
<tr>
<td></td>
<td>interface of the product.</td>
</tr>
</tbody>
</table>

**24-Hour Access to Calls, SPRs, and TANs**

You can track your calls and SPRs 24 hours a day on the PTC Web site using Call Tracker and Pro/SPR TRACKER. With these applications, you can view the calls and SPRs filed by your company to PTC Technical Support. These tools provide searching, tracking, and sorting capabilities. Call Tracker also allows you to add comments to a call. When comments are added, the technical support engineer or license management representative assigned to your call is notified automatically.

You can search for Technical Application Notes (TANs) using the Update Advisor. TANs are documents, written by technical support engineers that describe software functionality, alternative techniques, and common software issues. The TANs also tell you in which release of the software issues were discovered and in which releases they are resolved.
Connecting to the PTC Technical Support Web Site

Use the following procedure to connect to the PTC Technical Support Web site:


2. Click Technical Support and log in to the Technical Support section. If you do not have an account to log on to, you can request one at the PTC Web site or by calling PTC Technical Support at the number for your local office listed at the back of this guide.

PTC Online Accounts

To use the Technical Support areas of the PTC Web site, you must register for a PTC online account. Go to www.ptc.com and select Sign-up Online! from the Technical Support page. Sign up for a PTC Customer Online Account. After you submit the form, you will receive a call number. Your online account will be considered unverified and you will have limited access to certain functions on the PTC Web site. You must verify your account by following the instructions that will be sent to you via e-mail.
**Index**

**A**
- Apache  
  - support contract for, 7-13
- API  
  - support for, 7-7  
  - usage of, 7-7  
    - decompiling source code, 7-8  
    - supported languages, 7-8
- Assessment Services, 2-7

**C**
- CADDS  
  - determining release and version number, 5-3  
  - gathering required information for PTC Technical Support, 6-2
- Call Logger  
  - about, 5-5, 5-12  
  - using to upload a file to Technical Support, 6-14
- Call Tracker  
  - accessing calls, SPRs, and TANs with, 8-4  
  - checking an enhancement request, 5-12  
  - on PTC Web site, 3-9  
  - Technical Support calls, 5-5
  - using to upload a file to Technical Support, 6-14
- calling  
  - License Management  
    - escalating your issue, 3-10  
    - following up your call, 3-9  
    - preparing for your call, 3-8  
    - resolving your call, 3-9
  - PTC Technical Support  
    - opening a call, 5-4  
    - preparing for your call, 5-4  
    - tracking a call, 5-4
- command-line program, connecting to the PTC File Transfer Protocol (FTP) server from, 6-12
- configuration of third-party products in Windchill, 7-10
- configurations for Windchill, 7-4
- Consulting Services, 2-6
- Contracts, 2-5
- Convera RetrievalWare  
  - issues with, 7-11  
  - support contract for, 7-13  
  - Windchill support for, 7-11
- Corporate Learning Programs, 2-6
- Credit and Collections, 2-5

**Index-1**
Index-2

PTC Customer Service Guide

Departments, 1-2
Distribution, 2-5
Maintenance Support, 2-2
Order Management, 2-5
overview, 2-1
PTC Global Services, 2-6
Customer Detailed License Report, 3-3
Customer Service
Customer Care Center, 1-2
departments, 1-2
identifying group to contact, 1-2
License Management, 3-2
placing a software order, 3-2
customization of Windchill
about, 7-2
customer source code examples, 7-7
requirements for, 7-3
support for, 7-3
using programming styles, 7-7
using the customization toolkit, 7-2

D
data
sending by e-mail, 6-13
sending on floppy disk, Zip disk, CD, or tape, 6-11
sending using Call Logger, 6-14
sending using Call Tracker, 6-14
sending using the PTC File Transfer Protocol (FTP) server, 6-11
dataloader tools, support for, 7-6
decompling source code, 7-6
determining release and version of a product
CADDs, 5-3
DIVISION ProductView, 5-3
Electronic Design Entry (EDE), 5-3
EPD.Connect, 5-3
Optegra Vault (UNIX), 5-3
Optegra Vault (Windows), 5-3
Pro/ENGINEER, 5-3
Pro/INTRALINK, 5-3
Routed System Designer, 5-3
Simulation, 5-3
Windchill DynamicDesignLink, 5-3
Windchill PartsLink, 5-3
Windchill PDMLink, 5-3
Windchill ProductView, 5-3
Windchill ProjectLink, 5-3
Windchill Visualization, 5-3
DIMENSION III
gathering required data for PTC Technical Support, 6-2
Distribution, 2-5
DIVISION ProductView
determining release and version number, 5-3
gathering required data for PTC Technical Support, 6-2
documentation. See reference documentation

E
Electronic Design Entry (EDE)
determining release and version number, 5-3
gathering required data for PTC Technical Support, 6-2
enhancements for products, 5-11
submitting an enhancement request, 5-11
tracking enhancement requests, 5-11
EPD.Connect
determining release and version number, 5-3
error tracking in customized Windchill Solutions, 7-4
escalating
license management issues, 3-10
technical issues (SPRs), 5-7
Europe, License Management phone support, 3-7

F
Far East, License Management phone support, 3-7
Feedback Line, 4-3
FTP client with graphic user interface connecting to the PTC File Transfer Protocol (FTP) server from, 6-12
FTP server. See PTC File Transfer Protocol (FTP) server
G

gathering required data
   for Windchill Visualization, 6-7
Global Services
   PTC Global Services. See

I

IDE (Integrated Development Environment), 7-11
issues with, 7-11
   Windchill support for, 7-11
Implementation Services, 2-6
Info*Engine products
   gathering required data for PTC Technical Support, 6-2
   support contract for legacy databases, 7-13
Information Modeler
   Windchill, 7-7
installation and configuration issues
   in Windchill
   PTC Technical Support, 6-7
Windchill
   PTC Technical Support, 6-7
installation guides, 8-4
installation of third-party products in
   Windchill, 7-10
Integrated Development Environment. See
   IDE
ISO 9000
   certification, 4-2
   meaning of, 4-2
issues
   escalation of
      License Management, 3-10
   escalation of SPRs, 5-7
   in third-party products in Windchill, 7-10
   troubleshooting, 5-2
ITAR data transfer, 6-10

J

Java programming in Windchill, support
   for, 7-7
JavaScript, 7-9

K

Knowledge Base
   about, 8-2
   frequently asked questions (FAQs) in, 8-2
   hardware configuration information in, 8-2
   suggested techniques in, 8-2
   technical application notes (TANs) in, 8-2
   technique points of interest (TPIs), 8-2
Knowledge Base monitor, 8-3

L

languages supported by Windchill Solutions, 7-8
license codes
   accessing, 3-3
   obtaining, 3-3
   requesting a Detailed License Report, 3-3
License Management
   accessing license information, 3-3
   calling
      escalating your issue, 3-10
      following up your call, 3-9
      preparing for your call, 3-8
      resolving your call, 3-9
   contacting, 3-2
   Europe phone support, 3-7
   Far East phone support, 3-7
   international offices, 3-7
   license simplification, 3-7
   modifying license configuration, 3-5
   North America phone support, 3-7
   obtaining license codes, 3-3
   phone support, 3-7
   placing an order, 3-2
   privilege levels, 3-6
   PTC Web tools, 3-2, 3-6
   reconfiguring software licenses, 3-5
   requesting a Detailed License Report, 3-3
   requesting a new license pack, 3-4
   sales order number (SON), 3-4
   services provided, 3-2
   tracking a call, 3-9
   transferring licenses, 2-5
   updating current address and hardware information, 3-4
licenses
requesting new license pack, 3-4
simplification of, 3-7
transferring, 2-5
verifying information, 3-4
LM. *See* License Management

**M**
maintenance contracts
  Maintenance Support program, 2-3
  purchasing, 2-2
  upgrading, 2-5
Maintenance Support
  contacting your representative, 2-2
  Web site, 2-5
Mechanica. *See* Simulation
modification of classes
  in Windchill, 7-8
  modifying license configurations, 3-5

**N**
NDA data transfer, 6-9
non-disclosure agreements, 6-9
North America
  License Management phone support, 3-7
  PTC Technical Support, 5-5

**O**
online accounts, 8-5
opening a call
  PTC Technical Support
    by e-mail, 5-5
    by telephone or fax, 5-5
    on PTC Web site, 5-5, 5-12
  to License Management
    preparing for, 3-8
Optegra
  gathering required data for PTC
    Technical Support, 6-2
Optegra Vault (UNIX), determining release
and version number, 5-3
Optegra Vault (Windows), determining
release and version number, 5-3
Oracle database
  instance blocks, 7-11

issues with, 7-11
  support contract for, 7-13
  Windchill support for, 7-11
Order Management, 2-5

**P**
phone support for License Management, 3-7
PLM On Demand
  about, 7-13
  following up a logged call, 7-14
  use by the Super User, 7-14
privilege levels for License Management, 3-6
Pro/ENGINEER
  determining release and version number,
    5-3
  gathering required data for PTC
    Technical Support, 6-3
Pro/FICENCY Tool, 2-6
Pro/INTRALINK
  determining release and version number,
    5-3
  gathering required data for PTC
    Technical Support, 6-4
Pro/SPR TRACKER
  about, 5-7
  accessing calls, SPRs, and TANs with, 8-4
products
  enhancement for, 5-11
ProductView
  support contracts for CAD and PDM
    systems, 7-13
programming styles, support for, 7-7
PTC File Transfer Protocol (FTP) server
  about, 6-11
  connecting to
    from a command-line program, 6-12
    from a Web browser, 6-13
    from an FTP client with graphics user
      interface, 6-12
  requirements for sending data, 6-12
PTC Global Services
  about, 2-6
  Consulting Services, 2-6
  Implementation Services, 2-6
  training services, 2-6
PTC Service Contract Number, 5-4

PTC Technical Support
benefits of, 4-2
Call Logger, 8-3
Call Tracker, 8-3
calling
opening a call, 5-4
preparing for your call, 5-4
tracking a call, 5-4
contacting
pre-call checklist, 5-2
departments, 1-3
Feedback Line, 4-3
gathering required data
for CADDS, 6-2
for DIMENSION III, 6-2
for DIVISION ProductView, 6-2
for Electronic Design Entry (EDE), 6-2
for Info*Engine products, 6-2
for Optegra, 6-2
for Pro/ENGINEER, 6-3
for Pro/INTRANALINK, 6-4
for Routed Systems Designer, 6-5
for Simulation, 6-4
for Windchill configuration issues, 6-7
for Windchill Import/Export, 6-6
for Windchill Information Modeler, 6-6
for Windchill installation issues, 6-7
hardware configuration information, 8-2
ISO 9000 certification of, 4-2
Knowledge Base monitor, 8-3
North America, 5-5
opening a call
by e-mail, 5-5
by telephone or fax, 5-5
on the PTC Web site, 5-5, 5-12
Pro/SPR TRACKER, 8-3
resolving your question, 5-6
securing data for transfer, 6-9
sending data to
by e-mail, 6-13
multiple files, 6-8
on floppy disk, Zip disk, CD, or tape, 6-11
using Call Logger, 6-14
using Call Tracker, 6-14

using the PTC File Transfer Protocol (FTP) server, 6-11
sending multiple files to
from a UNIX platform, 6-8
from a Windows platform, 6-9
service contract number, 5-4
software update request, 8-3
South America, 5-5
SPRs, 5-7
support contract
for Apache, 7-13
for Convera RetrievalWare, 7-13
for Rational Rose, 7-13
for Tomcat, 7-13
support of Windchill Solutions releases, 7-5
tracking a call on the PTC Web site, 5-5, 5-12
understanding call priority, 5-9
understanding escalation levels, 5-10
Update Advisor, 8-3
Web site
about, 8-2
frequently asked questions (FAQs), 8-2
Knowledge Base, 8-2
PTC Web tools, 8-3
reference documentation, 8-4
SPRs on, 8-4
suggested techniques, 8-2
technical application notes (TANs), 8-2
technical points of interest (TPIs), 8-2
Windchill, 7-6
customer source code examples, 7-7
for Java programming, 7-7
usage of API, 7-7
Windchill Customization, 7-6
PTC Technical Support Web site
connecting to, 8-5
online account, 8-5
PTC Web site
PTC Technical Support
opening a call, 5-5, 5-12
tracking a call, 5-5, 5-12
URL, 5-2
tracking calls on, 3-9
PTC Web tools
about, 8-3
Call Logger, 8-3
Call Tracker, 8-3
Knowledge Base monitor, 8-3
License Management, 3-2, 3-6
on PTC Technical Support Web site, 8-2
Pro/SPR TRACKER, 8-3
software update request, 8-3
Update Advisor, 8-3

Q
quick reference cards, 8-4

R
Rational Rose
issues with, 7-12
support contract for, 7-13
Windchill support for, 7-12
Read This Firsts, 8-4
reconfiguring software licenses, 3-5
reference documentation
about, 8-4
installation guides, 8-4
quick reference cards, 8-4
Read This Firsts, 8-4
release notes, 8-4
types of, xiii
release notes, 8-4
resolving your technical support question, 5-6
RetrievalWare. See Convera RetrivalWare
Routed Systems Designer
determining release and version number, 5-3, 6-5
gathering required data for PTC
Technical Support, 6-5

S
sales order number (SON), 3-3
securing data for transfer
about, 6-9
ITAR data, 6-10
NDA data, 6-9
sending data
to PTC Technical Support, 6-8
by e-mail, 6-13

from UNIX, 6-8
from Windows, 6-9
on floppy disk, Zip disk, CD, or tape, 6-11
using Call Logger, 6-14
using Call Tracker, 6-14
using the PTC File Transfer Protocol (FTP) server, 6-11
using the PTC File Transfer Protocol (FTP) server
connecting to, 6-12
requirements for, 6-12
Simulation
determining release and version number, 5-3
gathering required data for Technical Support, 6-4
software errors in third-party products in Windchill, 7-10
software orders
obtaining license codes for, 3-3
placing, 3-2
software performance reports. See SPRs
Software Performance Reports (SPR)
24-hour access to, 8-4
tracking, 8-4
software update requests, 8-3
SON. See sales order number
source code, decompiling, 7-8
South America
PTC Technical Support, 5-5
SPRs
escalating, 5-7
submitting, 5-7
tracking, 5-7
Structural and Thermal Simulation. See Simulation
support
for customizations of Windchill Solutions, 7-3
for Windchill configurations, 7-4
for Windchill Customization, 7-6
of Windchill releases, 7-5

T
technical support
offered by VARs, 4-2
Technical Support. See PTC Technical Support

Web site
Knowledge Base, 8-2

third-party products
configuration of in Windchill, 7-10 in Windchill
IDE (Integrated Development Environment), 7-11
issues in, 7-10
Oracle database, 7-11
Rational Rose, 7-12
support contracts for, 7-12
support for, 7-10
Web browsers, 7-12
Web servers, 7-12
interaction with Windchill Solutions, 7-3
installation of in Windchill, 7-10
JavaScript, 7-9
software errors in Windchill, 7-10

Tomcat
support contract for, 7-13

tracking calls
on the PTC Web site, 3-9
to PTC Technical Support, 5-5, 5-12

tracking enhancement requests, 5-11
Training Services, 2-6

troubleshooting, 5-2

U
UNIX, sending data from, 6-8
Update Advisor
about, 8-3
searching for TANs with, 8-4
upgrading a maintenance contract, 2-5
user documentation, 8-2
conventions, xiv
sending comments to PTC, xiv

V
value-added resellers
partnerships with PTC, 4-2
technical support for, 4-2
VARs. See value-added resellers
Visualization. See Windchill Visualization

W
Web browsers
connecting to the PTC File Transfer Protocol (FTP) server from, 6-13
issues with, 7-12
Windchill support for, 7-12
Web servers
issues with, 7-12
Windchill support for, 7-12
Web site
PTC Technical Support, 8-2
Windchill
classes
class extensions, 7-9
extensions of, 7-9
modification of, 7-8
use of, 7-9
customization
requirements for, 7-3
support of end users, 7-3
using programming styles, 7-7
using the customization toolkit, 7-2
Customization functionalities, 7-6
Info*Engine products, support contract for legacy databases, 7-13
Information Modeler, 7-7
License Agreement, 7-2
ProductView, support contracts with vendors of CAD or PDM systems, 7-13
PTC Technical Support
customer source code examples, 7-7
usage of API, 7-7
support for Java programming, 7-7
supported configurations, 7-4
supported releases, 7-5
third-party product support contract for Apache, 7-13
for Convera RetrievalWare, 7-13
for Oracle database, 7-13
for Rational Rose, 7-13
for Tomcat, 7-13
third-party products
configuration of, 7-10
Convera RetrievalWare, 7-11
IDE (Integrated Development Environment), 7-11
installation, 7-10
issues in, 7-10
JavaScript, 7-9
Oracle database, 7-11
Rational Rose, 7-12
Rational Rose, 7-12
software errors in, 7-10
support contracts for, 7-12
support for, 7-10
use of, 7-9
Web browsers, 7-12
Web servers, 7-12
use of the API
  decompiling source code, 7-8
  JavaScript, 7-9
  supported languages, 7-8
Web browsers
  Internet Explorer, 7-12
  Netscape Communicator, 7-12
Web servers
  Apache, 7-12
  Internet Information Server, 7-12
  Netscape Enterprise Server, 7-12
Windchill DynamicDesignLink,
determining release and version number,
5-3
Windchill Import/Export
gathering required data for PTC
  Technical Support, 6-6
Windchill Information Modeler
gathering required data for PTC
  Technical Support, 6-6
Windchill PartsLink, determining release
and version number, 5-3
Windchill PDMLink, determining release
and version number, 5-3
Windchill ProductView
determining the release number and
version, 5-3
Windchill ProjectLink, determining release
and version number, 5-3
Windchill Solutions
  customizing, 7-2
  dataloader tools, 7-6
  error tracking, 7-4
  interaction with third-party products, 7-3
  maintenance and patches, 7-15
  overview, 7-2
  support of releases, 7-5
  supported languages, 7-8
  third-party vendors, 7-13
Windchill Visualization
determining the release number and
version, 5-3
  gathering required data for PTC
  Technical Support, 6-7
Windows, sending data from, 6-9
PTC Support and Services
Worldwide Contact Information

Value-Added Reseller Technical Support
Customers of value-added resellers (VARs) should contact their VAR directly. To identify the VARs in your area, see www.ptc.com/partners/drp/index.htm.

PTC Electronic Support
Electronic services are available 7 days a week, 24 hours a day.

**URL:** www.ptc.com/support/index.htm

**E-Mail:**
- cs_ptc@ptc.com (For opening calls and sending data.)
- latinamericasupport@ptc.com (For Portuguese-speaking and Spanish-speaking customers only.)
- cs-webaccts@ptc.com (For Web account issues only. Customer Number and Service Contract Number (SCN) required.)
- cs-webmaster@ptc.com (For commenting about the Web site.)

**FTP:**
ftp.ptc.com

PTC Worldwide Technical Support
You can contact PTC for technical support, license management and Maintenance Support, and training services by telephone Monday through Friday in local time zones and local languages.

### North and South America

<table>
<thead>
<tr>
<th>Technical Support</th>
<th>Phone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within the United States</td>
<td>800-477-6435</td>
<td>781-707-0328 Needham, MA 651-494-3281 Arden Hills, MN</td>
</tr>
<tr>
<td>Brazil (toll-free Portuguese support)</td>
<td>0800-891-0978</td>
<td>1-781-370-0328</td>
</tr>
<tr>
<td>North and South America (Portuguese support – toll charge)</td>
<td>781-370-5555</td>
<td>1-781-370-0328</td>
</tr>
</tbody>
</table>

Contacts-1
<table>
<thead>
<tr>
<th>Customer Care Center</th>
<th>Phone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Management</td>
<td>877-275-4782 (877-ASK-4-PTC)</td>
<td>781-707-0331</td>
</tr>
<tr>
<td>Maintenance Support</td>
<td>877-275-4782</td>
<td>781-707-0322</td>
</tr>
<tr>
<td>Order Management</td>
<td>877-275-4782</td>
<td>781-707-0326</td>
</tr>
<tr>
<td>Training</td>
<td>877-275-4782</td>
<td>781-370-5307</td>
</tr>
</tbody>
</table>

**Europe**

<table>
<thead>
<tr>
<th>Customer Care Center</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>Belgium</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>Denmark</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>Finland</td>
<td>+44 1252-817600</td>
</tr>
<tr>
<td>France</td>
<td>+33 4-42-97-00-00</td>
</tr>
<tr>
<td>Germany</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>Ireland</td>
<td>+44 1252-817600</td>
</tr>
<tr>
<td>Italy</td>
<td>+39 039-65651</td>
</tr>
<tr>
<td>Netherlands</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>Norway</td>
<td>+44 1252-817600</td>
</tr>
<tr>
<td>Portugal</td>
<td>+34 91-452-0128</td>
</tr>
<tr>
<td>Portugal</td>
<td>+44 1252-817600</td>
</tr>
<tr>
<td>Spain</td>
<td>+39 039-65651</td>
</tr>
<tr>
<td>South Africa</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>Sweden</td>
<td>+44 1252-817600</td>
</tr>
<tr>
<td>Switzerland</td>
<td>+49 89-32106-0</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>+44 1252-817600</td>
</tr>
<tr>
<td>Other countries (English support)</td>
<td>+33 442-97-02-01</td>
</tr>
</tbody>
</table>

Services: Technical Support, License Management and Documentation, Training Registration, Consulting, Invoices
## Asia and Pacific Rim

<table>
<thead>
<tr>
<th></th>
<th>Phone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Australia</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>1-800-553-565</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td>Maintenance Support</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>China</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support Domestic Toll Free</td>
<td>800-810-0699</td>
<td>+86 21-58402080</td>
</tr>
<tr>
<td>Technical Support International Toll Free</td>
<td>10800-650-8185</td>
<td>+86 21-58402080</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td><strong>Hong Kong</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>+800 933309</td>
<td>+86 21-52929525</td>
</tr>
<tr>
<td>License Management and</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td>Maintenance Support</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>India</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>1 600 233-4599</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td>Maintenance Support</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Indonesia</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>001-803-65-7250</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td>Maintenance Support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support, License Management, Maintenance Support</td>
<td>Phone</td>
<td>Fax</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td><strong>Japan</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>0120-20-9023</td>
<td>+81 (0) 3-3346-8284</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+81 (0) 3-3346-8280</td>
<td>+81 (0) 3-3346-8262</td>
</tr>
<tr>
<td><strong>Malaysia</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>1-800-80-1026</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td><strong>New Zealand</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>0800-44-4376</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td><strong>Philippines</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>1027-1800-650-7019</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td><strong>Singapore</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>1800-830-9901</td>
<td>+91 20 5605 3009</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td><strong>South Korea</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support Domestic Toll Free</td>
<td>080-3469-001</td>
<td>+86 21-52929525</td>
</tr>
<tr>
<td>Technical Support International Toll Free</td>
<td>00798-65-1-7078</td>
<td>+86 21-52929525</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td>Technical Support, License Management, Maintenance Support</td>
<td>Phone</td>
<td>Fax</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Taiwan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support Domestic Toll Free</td>
<td>0800-013069</td>
<td>+86 21-52929525</td>
</tr>
<tr>
<td>Technical Support International Toll Free</td>
<td>00801-65-1256</td>
<td>+86 21-52929525</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
<tr>
<td>Thailand</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Support</td>
<td>001-800-65-6213</td>
<td>+91-20-5605-3009</td>
</tr>
<tr>
<td>License Management and Maintenance Support</td>
<td>+852 2802-8982</td>
<td>+852 2587-9095</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Training Services</th>
<th>Phone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Beijing</td>
<td>+86 10-65908699</td>
<td>+86 10-65908698</td>
</tr>
<tr>
<td>Guangzhou</td>
<td>+86 20-87554426</td>
<td>+86 20-87554416</td>
</tr>
<tr>
<td>Shanghai</td>
<td>+86 21-58401877</td>
<td>+86 2158402030</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>+852 28028982</td>
<td>+852 25879095</td>
</tr>
<tr>
<td>India</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bangalore</td>
<td>+91 80-22129741</td>
<td>+91 80-22129747</td>
</tr>
<tr>
<td>Mumbai</td>
<td>+91 22-26553761</td>
<td>+91 22-26558079</td>
</tr>
<tr>
<td>New Delhi</td>
<td>+91 11-51612233</td>
<td>+91 11-51612232</td>
</tr>
<tr>
<td>Japan</td>
<td>+81 3 33468642</td>
<td>+81 3-3346-8643</td>
</tr>
<tr>
<td>Malaysia</td>
<td>+60 3-7954-8198</td>
<td>+60 3-7954-8197</td>
</tr>
<tr>
<td>Training Services</td>
<td>Phone</td>
<td>Fax</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>South Korea</td>
<td>+82 2-3484-8181</td>
<td>+82 2-3484-8190</td>
</tr>
<tr>
<td>Taiwan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kaohsiung</td>
<td>+886 7-5665266</td>
<td>+886 7-566-5907</td>
</tr>
<tr>
<td>Taichung</td>
<td>+886 4-2310-3311</td>
<td>+886 4-2310-3334</td>
</tr>
<tr>
<td>Taipei</td>
<td>+886 2-2758-8600</td>
<td>+886 2-8788-3575</td>
</tr>
</tbody>
</table>

**Technical Support Customer Feedback Line**

The Technical Support Feedback Line is for general Technical Support concerns. For assistance with technical issues, use the electronic services or the Technical Support phone numbers as listed previously.

To provide feedback via the Web, submit your comments and suggestions to PTC Technical Support at [www.ptc.com/support/feedback/ts.htm](http://www.ptc.com/support/feedback/ts.htm).

To discuss any general, nontechnical issues with a technical Support manager, call the number for your region listed below.

**Worldwide Technical Support Customer Feedback Phone Numbers**

<table>
<thead>
<tr>
<th>Region</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td>1-888-782-3772</td>
</tr>
<tr>
<td>Europe</td>
<td>00 800 PTC 4 HELP option 7</td>
</tr>
<tr>
<td>Japan (domestic toll-free)</td>
<td>+0120 35-6211</td>
</tr>
</tbody>
</table>